Association For Consumer Research Conference 2023 26 - 29 Oct 2023 All times in PDT éfg

4:15pm PhD Project Mentoring Program Pre-Reception (Invite Only)
Willow B
Chaired by: Dr. Adriana Samper

Thu rsday, 26 October

7:30am Registration
Spruce 5:30pm Fellows Address
Grand Ballroom B

8am ACR Sheth Foundation Doctoral Symposium (Sponsored by Mays
Business School, Texas A&M University)

Grand Ballroom A

6:30pm Welcome Reception
Metropolitan B

8:30am JACR Pre-Conference Workshop on Consumer Privacy

Willow B .
Frlday, 27 October
7am Yoga
T1am ACR Board of Directors Meeting Everett
Willow A
7:15am Keith Hunt Newcomers' Breakfast
Cirrus Ballroom
Tpm Early Career Workshop (Sponsored by Northwestern University, 7:30am Registration
Medill School of Journalism, Media, Integrated Marketing Spruce
Communications)
G Bloies & 8am JMR AE/ERB Breakfast (Invite Only)
Virginia
Chaired by: Dr. Rebecca Hamilton
2pm Mid Career Workshop
Grand Ballroom D
8:15am 1.01 Special Session - Emotion in Decision: The Essential Interplay
Between Emotions and Decision-Making
Cedar

Chaired by: Dr. Oleg Urminsky
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Continued from Friday, 27 October 8:15am

8:15am

A Global Analysis of How Emotions Relate to Economic Decisions
Regarding Time or Risk

» Mr. Samuel Pertl, Ms. Tara Srirangarajan, Dr. Oleg Urminsky

Using Emotions to Characterize Individual Differences in Risk
Preferences

» Prof. Barbara Mellers, Dr. Siyuan Yin

Moment-to-moment changes in expectations predict happiness
» Dr. Ming Hsu, Dr. Deborah Marciano, Ms. I[da Mayer

Social media users’ posting behavior can be as-if addictive and
can have negative emotional consequences

» Dr. Felix Jan Nitsch, Dr. Klaus Wertenbroch, Dr. Hilke Plassmann

1.02 Special Session - From Buy to Bye: Promoting Sustainability in
Product Choice and Disposal

Issaquah
Chaired by: Ms. Suwon Choi

8:15am

Spurring Secondhand Clothing Consumption Through Moral
Disgust for New Fashion

» Ms. Hannah Smith, Prof. Karen Page Winterich

Will Consumers Rent What They Buy? How Deciding to Rent is
Different from Deciding to Buy

» Ms. Suwon Choi, Dr. Claudia Townsend

Symbolic Punishment through Destructive Product Disposal
» Dr. Aaron Brough, Prof. Mathew Isaac

Understanding When Consumer Empowerment Initiatives Fail to
Increase Participation in Corporate Take-Back Programs

» Dr. Kristin Hurst, Dr. Atar Herziger, Dr. Grant Donnelly
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1.03 Special Session - Algorithms, Consumer Preferences, and
Perceptions

Jefferson
Chaired by: Ms. Qiao Liu

Aligning algorithms with consumers’ prediction preferences
» Prof. Berkeley Dietvorst

Consumer Preference for Algorithmic vs. Human Evaluation
» Ms. Qiao Liu, Prof. Gerald Haubl

Consumers' Lay Beliefs about Al Assessment of Interpersonal
Skills

» Mr. llyung Cheong, Prof. Young Eun Huh, Prof. Stefano Puntoni

The Hedonic Cost of Robotic Services
» Dr. Phyliss Gai, Dr. Yiqi Yu, Ms. Liyi Tang

1.04 Special Session - Consumer Communication in Digital Contexts
Willow A
Chaired by: Ms. Yusu Wang

Short and Sweet or Short and Sour: The Influence of Text Message
Abbreviations on Relational Outcomes

» Ms. Liang Yang, Mr. David Fang, Prof. Sam Maglio

Grinners Gain More Followers: Signaling Status through High
Arousal Emotional Expressions on Social Media

» Ms. Yusu Wang, Prof. Keith Wilcox, Dr. Jeffrey Lee

I Really Know You: How Influencers Can Increase Audience
Engagement by Referencing Their Close Social Ties

» Dr. Jaeyeon Chung, Prof. Yu Ding, Dr. Ajay Kalra

The Past and Future of Consumer Language Research

» Prof. Jonah Berger, Prof. Grant Packard
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Continued from Friday, 27 October

8:15am

8:15am

1.05 Special Session - Consumer (Dis)identification: When
Consumers Don’t Identify with Consumption Behaviors

Willow B
Chaired by: Prof. Stephanie C. Lin

The Perceived Durability of Past Experiences

» Prof. Jacqueline Rifkin, Prof. Anja Schanbacher, Prof. Nazli Gurdamar-
Okutur

Unclearly Immoral: How Self-Concept Clarity Shapes Moral
Behaviors

» Ms. |ane Jiagian Wang, Prof. Rima Touré-Tillery 8:15am

Poser Avoidance: Low Identity Entitlement Leads to Avoidance of
Identity Signaling
» Prof. Stephanie C. Lin, Prof. Rebecca Schaumberg

Person-Related Terms in Product Reviews: When Subtle Identity
Cues Reduce Product Preference

» Mr. Byung Cheol Lee, Prof. Liad Weiss

1.06 Roundtable - Emerging Technologies and Consumer Well-being:
Peril and Promise

Ravenna
Chaired by: Dr. Ainslie E. Schultz and Dr. Meryl P. Gardner
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Emerging Technologies and Consumer Well-Being: Peril and
Promise

» Dr. Meryl P. Gardner, Dr. Ainslie E. Schultz, Dr. Stacey Menzel Baker,
Dr. Wilson Bastos, Dr. Russell Belk, Dr. Andrea Bonezzi, Dr. Simona
Botti, Dr. Melanie Brucks, Dr. Frank Cabano, Dr. Pierre Chandon, Dr.
Luca Cian, Dr. June Cotte, Ms. Marina Cozac, Dr. Benét DeBerry-
Spence, Dr. Matthew Farmer, Dr. Lane Peterson Fronczek, Dr. Markus
Giesler, Dr. Kristina Harrison, Dr. Kelly L. Haws, Dr. Ronald Paul Hill, Dr.
Daniel R. Horne, Dr. Elizabeth Howlett, Dr. Liang Huang, Dr. Chris
Hydock, Dr. Shailendra Pratap lain, Dr. Mansur Khamitov, Dr. Melika
Kordrostami, Dr. Aleksandra Kovacheva, Dr. Kirk Kristofferson, Dr.
Kristen Lane, Dr. Jaehoon Lee, Dr. Leonard Lee, Dr. Monika Lisjak, Dr.
Andre F. Maciel, Dr. Martin Mende, Prof. Anirban Mukhopadhyay, Dr.
Nea North, Dr. Stephanie Geiger Oneto, Dr. Massimiliano Ostinelli, Dr.
Aniruddha Pangarkar, Dr. Ruth Pogacar, Dr. Rebecca Rabino, Dr.
Martin Reimann, Dr. Jennifer Savary, Dr. Ann Schlosser, Dr. Anu
Sivaraman, Dr. Adam Stivers, Dr. Hesam Teymouri, Dr. Beth Vallen, Dr.
Madhu Viswanathan, Dr. Tiffany Barnett White, Dr. Scott A. Wright, Ms.
Sahel Zaboli

1.07 Beyond Conventional Marketing Approaches: Exploring Green
Messaging, Virtual Influence, and Neuro-Engagement

Aspen
Chaired by: Prof. Luming Wang

Green Consumption and Message Framing
» Ms. Min Zhang, Prof. Luming Wang

The Role of Virtual Influencers in Fashion Diffusion
» Mr. Yuri Martirosyan, Dr. Deniz Atik

Do They WOW? Measuring Awe Using Online User Comments
» Mr. Zitian Qiu, Prof. Felicitas Morhart, Prof. Francine Petersen

Less is Not Always More: Fewer Words in Television Commercials
Decrease Brain Engagement

» Dr. Robert Torrence, Ms. Kailey Dougherty, Dr. Samuel Barnett
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Continued from Friday, 27 October

8:15am

8:15am

1.08 The Green Consumer: Understanding Recycling Practices and
Sustainability Choices

Columbia
Chaired by: Dr. Aylin Cakanlar

Recycle Right: How to Decrease Recycling Contamination Without
Sacrificing Recycling Rates?
» Dr. Megan Hunter, Dr. Gergana Nenkov, Dr. Aylin Cakanlar

Sustainability Considerations, or Lack Thereof, in Consumer
Decision Making

» Ms. Larissa Elmor, Mr. Guilherme Ramos, Dr. Yan Vieites, Mr.
Bernardo Andretti, Dr. Eduardo B. Andrade

Understanding and Nudging Consumer Reactions to Near-Expired
Products

» Dr. Yongheng Liang, Dr. Yunlu Yin, Dr. Qian Xu

Consumers are Less Likely to Recycle Personally Sensitive
Products

» Dr. Tianjiao Yu, Dr. Stephen Nowlis

1.09 From Faith to Politics: Unraveling the Intersections of
Spirituality, Corporate Activism, and Political Beliefs in Consumer
Behavior

Seneca
Chaired by: Dr. Stacey Brennan

Spiritual Brand Names Prime Environmental Sustainability
Perceptions, Preference, and Behavior

» Dr. Jasmina llicic, Dr. Stacey Brennan

From Piety to Preservation: Beliefs in A Punitive (vs. Benevolent)
God Decrease Green Behavior

» Mr. Yafei Guo, Dr. Sarah Lim
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8:15am

8:15am

Corporate Neutrality: Consumer Response to Brand Activism
» Mr. |effrey Kang, Prof. Manoj Thomas

Counter Projection of Political Orientation onto Elites Reduces
Satisfaction with Democracy

» Mr. Cory Haltman, Prof. Jesse Walker

1.10 Consumer Choices in Health: Navigating Persuasion, Guilt,
Pleasure, and Perception

Boren
Chaired by: Dr. Romain Cadario

Boosting vaccination uptake: what makes text-based reminders
more persuasive?

» Dr. Romain Cadario, Ms. Jenny Zimmermann, Dr. Bram Van den
Bergh

Strategic Media Bingeing

» Ms. Rachele Ciulli, Mr. Henrique Laurino Dos Santos, Dr. Annie
Wilson, Dr. Nate Warren, Dr. Cait Lamberton

Caregiving Responsibilities Discourage Leisure Consumption
» Prof. Ximena Garcia-Rada, Dr. Anika Schumacher

The Healthy Touch of Green Energy: How Food Made by Green
Energy Positively Impacts its Healthiness Perception

» Dr. Iman Paul, Dr. Smaraki Mohanty, Dr. Jeff Parker

1.11 Reimagining Consumer Interactions: Insights from Al, Bots, and

Gaming
Greenwood
Chaired by: Dr. Fanny Cambier

Creative contests: When poor corporate reputation attracts
consumer participation

» Dr. Fanny Cambier, Dr. Nadia Steils
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8:15am

8:15am

The Dark Side of Bots: How Consumer-Developed Bots Impact the
Competitive Landscape for Scarce Offerings

» Ms. Abby Frank, Dr. John A. Clithero

In the Wrong Zone: Flow State Amplifies Disposition Effect in
Trading for Gamers

» Dr. Hongjun Ye, Mr. Youngdai Won, Dr. Yuan Zhang

Enhancing Virtual Influencer Advertising Effectiveness: The Role
of Product Experiencing Behavior

» Prof. Zichuan Mo, Ms. Qiu Yuchen, Ms. Lisha You

1.12 Cultural Complexity in Consumer Behavior: From Norm
Disruption to Cynicism

Redwood A&B

Chaired by: Prof. Elizabeth Miller

Consumer Responses to Norm Disruption in Unsettled Times
» Prof. Clark Cao, Dr. Matthew Godfrey, Prof. Elizabeth Miller

Theorizing Obstacles and Opportunities to the Formation of
Legitimacy in lllicit Markets

» Ms. Carol Jianwen Wei, Prof. Julie Ozanne, Prof. Daiane Scaraboto

Failing to reconfigure: the breakdown of collocated practices and
the transformation of social life

» Dr. Pierre-Yann Dolbeg, Dr. Eileen Fischer, Ms. Ghalia Shamayleh

Consumer Cynicism: When Consumption Fails as Cultural Tool for
Distinction

» Dr. Indirah Indibara, Dr. Sanjeev Varshney, Dr. Munish Thakur

1.13 Tutorial - Process Analysis
Metropolitan B
Chaired by: Tatiana Dyachenko and Arash Laghaie and Constant Pieters
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8:15am

9:30am

9:45am

» Constant Pieters (Presenter)

1.14 Film Festival Session |
Capitol Hill

Face Value
» Dr. Lena Cavusoglu, Dr. Russell Belk

A Death Like No Other: The Lived Experiences Of COVID-19
Bereavement

» Prof. Lynn Sudbury-Riley

Trash or Treasure: Young Consumers & the Post-Purchase Journey
of Luxury Packaging

» Ms. Gretchen Honer, Dr. Jessica Weeks, Dr. Moumita Gyomlai, Dr.
Jacob Hiler

Coffee Break
Grand Ballroom PFA

2.01 Special Session - Spreading Good...Well through the
Transformative Advertising Research Framework: Examining Social
Inequalities in Advertising and Media

Cedar
Chaired by: Dr. Samantha Cross

Marketing Virtual Influencers: Gender and Well-being in
Advertising and Media

» Prof. Linda Tuncay Zayer, Dr. Catherine Coleman, Dr. Lauren Gurrieri

Colorism in Advertising
» Ms. Jazmin Henry, Dr. Tonya Bradford

Sexual Health Advertising
» Dr. David Rowe, Prof. Shona Bettany
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Continued from Friday, 27 October 9:45am

9:45am

9:45am

2.02 Special Session - Toward More Impactful Consumer Research:
Three Complementary Perspectives

Issaquah
Chaired by: Dr. Bernd Schmitt and Dr. Michel Pham

The Role of Novelty in Three Types of Impact

» Dr. Shane Wang, Dr. Joseph Ryoo, Dr. Margaret Campbell, Prof.
Jeffrey Inman

Two Types of Theoretical Contributions in Marketing Research:
Construct-To-Construct Versus Phenomenon-To-Construct

Mapping
» Dr. John Lynch, Prof. Stijn van Osselaer, Dr. Patricia Torres

Benchmarking Thought Leadership in Consumer Research: The p-
Index

» Dr. Michel Tuan Pham, Ms. Alisa Wu, Ms. Dangi Wang

2.03 Special Session - Preservation Nation—Using Social Problems to
Challenge and Extend Core Consumer Concepts

Jefferson
Chaired by: Prof. Lucie Ozanne

9:45am

Makeshifting as a Disruptive Social Practice

» Dr. Marcia Christina Ferreira, Prof. Daiane Scaraboto, Dr. Bernardo
Figueiredo, Dr. Adriana Schneider Dallolio, Prof. Eliane Zamith Brito

Forging Deeper Object Attachments by Intensive Mending
» Ms. Carol lianwen Wei

The Materiality of Repair Service Relationships
» Dr. Matthew Godfrey, Prof. Linda Price

Expanding Collective Action in Repair Cafes: A World of Concern
Approach

» Prof. Lucie Ozanne, Prof. Julie Ozanne
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2.04 Special Session - A Touchy Subject: The Positive and Negative
Effects of Touch on Consumer Behavior

Willow A
Chaired by: Dr. Ann Schlosser

Balancing Consumers’ Need to Touch Products Against Their
Germaphobia: The Combined Positive and Negative Effects of
Touch

» Mr. Kevin Jiang, Dr. Ann Schlosser, Dr. Katie Quinn

The Effects of Haptic Sensation on Product Interaction

» Mr. Wonsuk Jung, Prof. Joann Peck, Dr. Bowen Ruan, Prof. Anders
Gustafsson, Prof. Liangyan Wang

What Does it Feel Like? Comparing Communication of Haptic
Experiences to Communication of Visual Experiences

» Dr. Ann Schlosser, Prof. Morgan Poor Miles, Dr. Ryan Elder

The Mixed-Reality Effect: How Consumers’ Physical Reality
Influences Preferences for Virtually Displayed Products

» Mr. David Finken, Prof. Reto Hofstetter, Dr. Aradhna Krishna, Prof.
Florian von Wangenheim

2.05 Special Session - Understanding Aging Consumers from
Different Perspectives

Willow B
Chaired by: Ms. Lu Fang

Does Green Behavior Fade with Graying? The Role of Time
Perspectives in Older Adults’ Sustainable Consumption

» Ms. Yeonjin Sung, Prof. Alessandro M. Peluso, Prof. Cesare Amatulli,
Prof. Gianluigi Guido, Prof. Carolyn Yoon

Affective Forecasting Improves Across the Life Span
» Prof. Ye Li, Dr. Lisa Zaval, Prof. Eric]. Johnson

How Recommender’s Age Affects Utilitarian vs. Hedonic

Perceptions of a Recommended Product
» Ms. Qiangian (Esther) Liu, Dr. Suhas Vijayakumar, Prof. Yuwei Jiang
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Continued from Friday, 27 October 9:45am

9:45am

9:45am

Appraising Intrinsic Motivation from Age and Attractiveness:
Positive Implications in C2C Contexts

» Ms. Lu Fang, Prof. Anirban Mukhopadhyay

2.06 Roundtable - Emerging Threats to Democracy
Ravenna
Chaired by: Mr. Mohamed Hussein

Emerging Threats to Democracy
» Mr. Mohamed Hussein, Dr. Kathleen Vohs, Dr. Stephanie Chen, Prof.
Gita Johar, Dr. Ellie Kyung, Dr. Selin Malkoc, Dr. Brent McFerran, Dr.

Oded Netzer, Prof. Nailya Ordabayeva, Dr. |ake Teeny, Dr. Zakary L.
Tormala, Dr. Norbert Schwarz, Prof. Katherine White, Dr. Wendy Wood

2.07 Embracing Diversity and Disruption: Examining Branding and
Marketing Complexities

Aspen
Chaired by: Mrs. Nicole Davis

Mixed Couples, Mixed Attitudes: How Interracial Couples’
Representation Influences Brand Outcomes

» Mrs. Nicole Davis, Dr. Rosanna K. Smith, Dr. Julio Sevilla

Controversies and Brands: A Study on Digital Rhetorical Arenas
» Prof. Damien Renard

Does Featuring People with Disabilities Help or Hurt Fashion
Marketing Effectiveness?

» Ms. Jane Jiagian Wang, Prof. Chuang Wei

A Nickname to Stay Away From: A Brand Power Perspective
» Prof. Zhe Zhang, Prof. Ning Ye, Prof. Matt Thomson

Powered by Ex Ordo, everything you need to run a research conference.

9:45am

2.08 Sustainable Consumer Behavior: Perceptions, Parenthood,
Recycling, and Rating Trends

Columbia
Chaired by: Ms. Hanife Armut

Products that Stay with Us: Physical Mobility Leads to Stronger
Preference for Durable Products

» Ms. Hanife Armut, Dr. GUnes Biliciler

Saving the Planet for Our Kids, or Not: How Parenting Affects
Sustainable Behavior

» Dr. Avlin Cakanlar, Dr. Hristina Nikolova

Going Green, Staying Calm: The Effect of Recycling on Consumers’
Willingness to Wait

» Ms. lulu shi, Dr. Linying (Sophie) Fan, Prof. Rongrong Zhou, Prof.
Jiewen Hong

Evaluation Inflation: Consumers Give Higher Product Ratings on
Transaction Sites than Communication Sites

» Ms. Ying Zeng, Dr. Claire Tsai, Dr. Wei Lu

2.09 You shall love your neighbor as yourself: Fostering Prosociality,
Encouraging Giving, and Embracing Simplicity

Seneca

Chaired by: Mr. Athi Karthick V

When We Compete, | Won’t Help: The Influence of Framing
National Achievement Cues on Prosocial Behavior

» Mr. Athi Karthick V, Dr. Arun Sreekumar

Donating Material Goods Used as Identity Markers: How Public
Meanings and Implicit Theories Deter Consumers from Donations

» Dr. |i Kyung Park, Prof. Hakkyun Kim

Near, Far, Wherever You Are: Understanding Distance Effects in
Consumer Donation Appeals

» Ms. Aimee Smith, Dr. Natalina Zlatevska
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Continued from Friday, 27 October

9:45am

9:45am

“From Accidental to Voluntary Simplification” - The impact of
economic hardship on sustainable lifestyles

» Prof. Julius Stephan, Prof. David B. Dose

2.10 Emotions on the Plate: How Feelings Impact Healthy Food
Consumption

Boren
Chaired by: Prof. Ruzica Brecic

Children’s associations of healthy and unhealthy at different ages

» Prof. Ruzica Brecic, Prof. Matthew Gorton, Dr. Luca Panzone, Dr.
Dario Cvencek

Date Labels, Disgust, And Discarded Food: How Date Labels Drive
Food Waste

» Dr. Jan André Koch, Prof. Jan Willem Bolderdijk, Prof. Koert van
Ittersum

Feeling Awe, Choosing Right: Awe Leads to Mindful Consumer
Choices

» Dr. Atul Kumar, Dr. Amogh Kumbargeri, Dr. Shailendra Pratap Jain,
Dr. Sukriti Sekhri, Mr. Yash Chakarvarty, Prof. Arvind Sahay

In the mood for health: How does emotion relate to healthy food
consumption?

» Dr. Rui Sun, Ms. Jieyi Chen, Dr. Oleg Urminsky

2.11 Al, Ethics, and Consumer Behavior: Unmasking the Unforeseen
Effects

Greenwood
Chaired by: Mrs. Almira Abilova

When Human Labor Does Not Paint a Pretty Picture
» Mrs. Almira Abilova, Dr. Mirjam Tuk
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9:45am

9:45am

The Dark Side of Generative Al: Chatbots and Mental Health

» Prof. Julian De Freitas, Mr. Ahmet K. Uguralp, Mrs. Zeliha Uguralp,
Prof. Stefano Puntoni

The Effect of Cosmetic Surgery on Unethical Behaviors: The
Moderating Role of Medical Al

» Dr. Li Huang, Dr. Natalie Truong, Prof. Priyali Rajagopal, Dr. Anil
Mathur

The Double-Edged Sword of Artificial Intelligent (Al) Agents: An
Examination of the Effectiveness of Al Agents

» Ms. Nifia Bianca Sayson, Prof. Valéry Bezengon, Prof. Bruno Kocher,
Dr. Michael Puntiroli

2.12 Culture, Clothing, Sharing, and Agency: Unraveling Consumer
Realities in a Connected World

Redwood A&B
Chaired by: Dr. Gaye Bebek

Gazing at our heritage: Chinese tourists’' consumption of the
Mount Lushan heritage space

» Dr. Amy Takhar, Dr. Gaye Bebek, Ms. Yan Zhong

Saris, Crop tops and Ripped Jeans: A Theory of Bluffing, Possible
Selves and Transformation

» Dr. Tanuka Ghoshal, Dr. Russell Belk

Mine, Yours, or Ours? How Digital Technology Affordances Impact
Sharing Practices

» Dr. Rebecca Mardon, Dr. Varala Maraj, Prof. Fleura Bardhi

Connected Running and the Politics of Assemblage
» Dr. Yasmine El Alami, Mathieu Alemany Oliver

2.13 Tutorials - Online sample experimental methods
Metropolitan B
Chaired by: Joe Goodman and Dr. Michael O'Donnell and Lieb Litman
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Continued from Friday, 27 October 11:15am

9:45am

11:15am

2.14 Film Festival Session Il
Capitol Hill

Beyond the Price Tag: Understanding the Role of Utilitarian and
Hedonic Incentives in Sales Promotions for Low-
Income Consumers

» Ms. Fabricia Volotdo Peixoto, Ms. Ana Tereza Delapedra, Ms. Tania
Veludo-de-Oliveira, Ms. Adriana Guedes Arcuri, Mr. Edgard Barki

An Investigation into Enoughness
» Mrs. Ai Nhan Ngo, Dr. Fuat A. Firat, Dr. Deniz Atik

3.01 Special Session - Digital Devices and Consumer Well-being
Cedar
Chaired by: Dr. Ana Valenzuela

Technology-Mediated Social Risk-Taking: The Influence of
Smartphone Use and Locus of Control

» Mr. Diogo Koch Alves, Dr. Ana Valenzuela

The Role of Mobile Devices in Developing Child Financial Literacy
» Dr. Lauren Grewal, Dr. Carl-Philip Ahlbom, Prof. Dhruv Grewal

Consuming and Sharing Information Without Regard for Reward?
The Anatomy of Twitter Habits

» Mr. lan A. Anderson, Dr. Wendy Wood

Replacing Unwanted Smartphone Habits with Desirable Habits
» Ms. Laura Zimmermann

Powered by Ex Ordo, everything you need to run a research conference.

11:15am

3.02 Special Session - Better Together: Building Stronger Connections

Through Social Interactions and Shared Consumer Experiences
Issaquah
Chaired by: Dr. Cindy Chan

Active Experiences Are More Socially Connecting Than Passive
Experiences

» Dr. Cindy Chan

Interpersonal Consequences of Joint Food Consumption for
Connection and Conflict

» Dr. Kaitlin Woolley, Dr. Sarah Lim

‘The Same Thing Happened to Me": Exploring Divergent Outcomes
of Common Brand Experiences

» Prof. Jacqueline Rifkin, Dr. Francesca Valsesia, Dr. Keisha Cutright

Hello, Neighbor: Interactions with Weak Ties in One’s Community
Can Increase Prosocial Behavior

» Dr. Amit Kumar, Dr. Max Alberhasky, Ms. Aprajita Gautam

3.03 Special Session - How Novel Product Attributes and
Marketplace Features Shape Consumers' Financial Decisions

Jefferson
Chaired by: Mr. Christoph Huller

Putting All of My (Our) Eggs in One Basket: Examining
Diversification in Dyadic and Individual Financial Decisions

» Dr. Hristina Nikolova, Dr. Yakov Bart

Budget Simulation Versus Market Stimulation: The Paradox
Undermining Financial Literacy Education

» Dr. Mary C Gilly, Dr. Stephanie Dellande, Dr. Russel Nelson, Dr. Hope
Schau

Precision in Financial Donation Requests

» Dr. Ashley Angulo, Dr. Daniel Oppenheimer, Dr. Lois Li, Mr. Samuel
Park
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Continued from Friday, 27 October

11:15am

11:15am

Gamified Financial Platforms Tempt Consumers to Make Riskier
Financial Decisions

» Mr. Christoph Huller, Dr. Martin Reimann, Dr. Caleb Warren

3.04 Special Session - Interventions and Measures for Social Media
and Smartphone-Related Well-Being

Willow A
Chaired by: Dr. Kelly L. Haws

Smartphone Incorporated: The Unexpected Benefit of Intentional
Smartphone Breaks for Cognitive Performance

» Ms. Marina Cozac, Dr. Gia Nardini, Dr. Camilla Song, Dr. Richard Lutz,
Dr. Colleen Bee, Dr. Aida Faber, Dr. Marina Girju, Dr. Naz Onell, Ms.
AnneMarie Rossi

11:15am

Social Media Wisdom: Conceptualization and Scale Development

» Dr. Michael Luchs, Dr. Sunaina Chugani, Dr. Abigail Schneider, Dr.
Tavleen Kaur

From the Inside Out: Exploring the Effect of Mindfulness-Based
Interventions on Social Media Usage Urge Among High School
Students

» Dr. Tessa Garcia-Collart, Dr. Ellen Campos-Sousa 11:15am

3.05 Special Session - The Different Implications for Consuming the
Arts versus the Sciences

Willow B
Chaired by: Dr. Aviva Philipp-Muller and Joseph Siev

Consuming Scientific versus Artistic Works Produced by
Perpetrators of Personal Misconduct

» Mr. Joseph Siey, Dr. Jake Teeny

Powered by Ex Ordo, everything you need to run a research conference.

Two Heads Are Better Than One: How Framing Scientists as
Communal Improves Consumer Support for Scientists and Their
Findings

» Dr. Aviva Philipp-Muller, Prof. Jesse Walker, Prof. Rebecca Reczek

Science Denial: Rooted in Religious Intolerance and Lack of
Religious Diversity
» Prof. Yu Ding, Prof. Gita Johar, Dr. Michael Morris

Art and Science talk different: The effect of language
concreteness-abstractness on Liking of TED Talks

» Dr. Gaetano (Nino) Miceli, Dr. Ernesto Cardamone, Dr. Maria
Raimondo

3.06 Roundtable - Discouraging Discarding: Exploring the Role of
Repair, Reuse, Repurposing, Restoration, and Maintenance in
Sustainable Consumption

Ravenna
Chaired by: Dr. Matthew Godfrey

Discouraging Discarding: Exploring the Role of Repair, Reuse,
Repurposing, Restoration, and Maintenance in Sustainable
Consumption

» Dr. Matthew Godfrey, Dr. Donald Lehmann, Prof. Linda Price, Dr.

Silvia Bellezza, Dr. Aaron Brough, Dr. Tonya Bradford, Prof. Lucie
Ozanne, Prof. Marie-Agnes Parmentier, Dr. |eff Parker, Prof. Daiane

Scaraboto, Dr. Meltem TUlre, Prof. Karen Page Winterich

3.07 Multisensory Consumer Journeys: Exploring the Impact of
Visuals and Music

Aspen
Chaired by: Dr. Yunhui Huang

Prefer Linear or Crooked? A Visual Representation Perspective
» Dr. Sakshi Aggarwal, Prof. Sanjeev Tripathi, Prof. Sudipta Mandal

TOUCHING THROUGH THE EYES: THE IMPACT OF VISUAL DENSITY

ON PERCEIVED SOFTNESS
» Mr. Youkai Xiao, Dr. Yunhui Huang
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11:15am

11:15am

Music To My Ears: How Music Influences Consumer Product Choice
» Mr. Zachary Plunk, Dr. Blair Kidwell

Desire for Intense Stimuli When Falling Short
» Dr. W. Yuna Yang, Prof. Rashmi Adaval, Dr. Christine Kim

3.08 Balancing Acts: From Leisure Choices to Judicial Decisions
Columbia
Chaired by: Ms. Robina Ghosh

Work Hard, Play Safe: When Busyness Reduces the Appeal of New
Leisure Experiences

» Ms. Robina Ghosh, Dr. Rajagopal Raghunathan

Judges' work schedule swings justice: The impact of non-standard
work schedule on pretrial bail decisions

» Ms. Kyoungmin Cho, Prof. Yeosun Yoon, Dr. Su Hwan Kim

Bringing Home the Bacon: How Inequality of Romantic Partners’
Incomes Impacts Joint Consumption

» Prof. Nicole Kim, Ms. Chengchen (Sheryl) Liu, Dr. Rebecca Hamilton

Manipulating Consumers with the Truth: Relative-Difference
Claims in Advertising and Inferences of Manipulative Intent

» Dr. Robert Madrigal, Dr. Catherine Armstrong Soule, Dr. Jesse King

3.09 Unlocking the Dynamics of Prosocial Behavior: Exploring
Perception, Bias, and Responsibility in Charitable Initiatives

Seneca
Chaired by: Dr. Jessica Li

You're more likely to say yes than to ask: People underestimate
how willing others are to donate time

» Dr. Jessica Li, Dr. Lauren Min, Mr. Slava Deniskin

Powered by Ex Ordo, everything you need to run a research conference.

11:15am

11:15am

Undeserving of Help: How People Form Judgments of Low-Income
Individuals’ Spending on Hedonic Activities

» Dr. Hoori Rafieian, Dr. Anubhav Aggarwal, Dr. Eric Hamerman

Harnessing Moral Wiggle Room in Consumption Experiences
» Ms. Shoshana Segal, Dr. Geeta Menon

Implicit Mindset and Preference for In-kind CSR Contributions
» Dr. Yuri Seo, Dr. Felix Septianto, Dr. Sankar Sen, Prof. Pragya Mathur

3.10 Savoring Consumer Behavior: From Perception to Plate
Boren
Chaired by: Dr. Zhihan Cui

Active Calculation of Financial Losses Increases Risk Perception
and Duration Sensitivity in Preventive Health Judgments

» Dr. Zhihan Cui, Dr. Lu Liu

Accessorizing Consumption: Putting Consumption Experience in
Context Increases Complementary Purchases

» Dr. Youjung Jun, Mr. Eric Park, Ms. Jennifer Sun

Don’t say “vegan” or “plant-based": Labeling gourmet food
baskets as healthy and sustainable improves choices for food
without meat and dairy

» Dr. Patrycja Sleboda, Prof. Wandi Bruine de Bruin, Ms. Tania Gutsche,
Prof. Joe Arvai

The Effect of Food Presentation on Consumers’ Plate-clearing
Tendency

» Ms. Yunzhi Huang, Prof. Jun Ye

3.11 The Human-Al Interaction Landscape: Authenticity,
Masculinity, Tentative Language, and Motion Patterns

Greenwood
Chaired by: Dr. Sokiente W. Dagogo-Jack
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11:15am

11:15am

Online Inauthenticity Increases Social Media Abandonment
» Dr. Sokiente W. Dagogo-Jack, Dr. Alex Kaju

Algorithms are Gendered: The Masculine Algorithms and Their
Influence on Consumers

» Dr. Yegyu Han, Dr. Sang Kyu Park, Dr. Chris Janiszewski

Effect of Al's Use of Tentative Language on Consumer Acceptance
of Product Recommendations

» Mr. Junhui Huang, Prof. Maggie Wenjing Liu

Self-Moving Products: Investigating Customer-Centric Motion
Design of New Technologies

» Ms. Jenny Zimmermann, Prof. Emanuel de Bellis, Prof. Reto
Hofstetter, Prof. Stefano Puntoni

3.12 Beyond Consumption: Unveiling Transformative Encounters
and Responsible Subjects in the Modern Age

Redwood A&B
Chaired by: Prof. Stéphane Borraz

| Don’t Feel Any Guilt: How Consumers Justify the Boundaries of
Their Ethical Green Consumption Practices

» Prof. Stéphane Borraz, Prof. Clément Dubreuil

GO FISHING! How Interspecies Becoming Develops Custodianship
Towards Nature

» Dr. Annetta Grant, Dr. Robin Canniford, Dr. Avi Shankar

It's my mind, NO it's AR’s mind! Theorizing Imagination and the
“Mind” in Augmented Reality

» Dr. Khaled El-Shamandi Ahmed, Dr. Russell Belk

3.13 Tutorial - Text Analysis
Metropolitan B
Chaired by: Prof. Ann Kronrod and Prof. Jonah Berger

Powered by Ex Ordo, everything you need to run a research conference.

12:30pm

2:30pm

2:30pm

A

LUNCH- Presidential Address (Sponsored by Northwestern
University, Medill School of Journalism, Media, Integrated Marketing
Communications)

Grand Ballroom (ABCD)

4.01 Special Session - Giving good gifts: How givers mispredict when
and what to gift

Cedar
Chaired by: Dr. Holly Howe

Money Can Buy Me Love: Gifts Are a More Effective Form Of Acute
Social Support Than Conversations

» Dr. Hillary Wiener, Dr. Tanya Chartrand, Dr. Holly Howe

Better Late than Never? Gift Givers’ Overestimation of
Relationship Harm from Late Gifts Can Lead to Both Better and
Worse Gifts for Recipients

» Dr. Atar Herziger, Dr. Grant Donnelly, Prof. Rebecca Reczek

Nobody Buys the Vacuum on the Wedding Registry: When Do
Consumers Prefer to Give Hedonic versus Utilitarian Gifts?

» Dr. Aviva Philipp-Muller, Dr. Grant Donnelly

Weight Stigma and Gift-giving: How A Gift Recipient's Body Type
Impacts Giver's Anticipated Appreciation

» Ms. Tongxi Wang, Dr. Michelle Daniels, Dr. Abhi Bhattacharya

4.02 Special Session - The Intervention and Impact of
Misinformation Sharing

Issaquah
Chaired by: Prof. Yu Ding

What makes fake-news sharers tick? Exploring how extracting
textual cues in their language can help predict fake-news sharing
and test interventions

» Prof. Gita Johar, Prof. Verena Schoenmueller, Prof. Simon Blanchard
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2:30pm

Sharing fake news, knowingly: Desires to connect and be
recognized promote misinformation spreading

» Dr. Hyun Euh, Ms. Hyerin Han, Prof. Rashmi Adaval

On the ethicality of resharing misinformation
» Dr. Gizem Ceylan, Prof. Deborah Small

Misinformation and mistrust mindsets
» Prof. Giandomenico Di Domenico, Prof. Yu Ding, Prof. Gita Johar

4.03 Beyond Binary: Unraveling Gender Perceptions in Consumer
Behavior

Jefferson

Chaired by: Ms. Maren Hoff 2:30pm
The Uneven Fluidity of Gender-fluid

» Ms. Maren Hoff, Dr. Silvia Bellezza

Gender-Ambiguous Voices and Social Disfluency

» Mr. Shahryar Mohsenin, Dr. Kurt Munz

Is Money Male? Implications of a Possible Money-Masculine

Association

» Ms. Aybike Mutluoglu, Prof. Laurence Ashworth

Read This Now! Impact of Assertiveness in Influencer Messages

» Dr. Sukriti Sekhri, Prof. Akshaya Vijayalakshmi

4.04 Special Session - Well-done and well-used: State-of-the-art

approaches for optimizing the production and utility of meta-

analyses in consumer research 2:30pm

Willow A
Chaired by: Dr. Gratiana Pol

Powered by Ex Ordo, everything you need to run a research conference.

Current Data Extraction Practices in Meta-Analysis Research and
How to Improve Them with the Help of Al

» Mrs. Dominika Niewiadomska, Dr. Gratiana Pol, Mr. Jude Calvillo, Dr.
ade Winn, Mr. Joseph Riley, Dr. Martin Eisend, Dr. Olga Koz, Mr. Rick
Wedgeworth

Enhancing the Utility of Meta-Analyses for Consumer Researchers
and Practitioners

» Dr. Gratiana Pol, Dr. Martin Eisend, Mr. Joseph Riley, Mrs. Dominika
Niewiadomska, Dr. Abhishek Borah, Dr. Deborah Maclnnis, Mr. Jude
Calvillo, Mr. Rick Wedgeworth, Mr. Roy Nijhof, Mr. Luciano Silvi

How Much Have We Learned About Consumer Research? A Meta-
Meta-Analysis

» Dr. Martin Eisend, Dr. Gratiana Pol, Mr. Joseph Riley, Mrs. Dominika
Niewiadomska, Mr. Rick Wedgeworth

4.05 Special Session - How Sharing Consumption Impacts Consumer
Choices and the Consumption Experience

Willow B
Chaired by: Ms. Hyebin Kim

The Six Dimensions of Shared Consumption Experiences
» Prof. Ximena Garcia-Rada, Prof. Peggy Liu, Ms. Theresa Kwon

It's My Party: Being a Host Leads People to Make Self-Expressive
Choices for Joint Consumption

» Ms. Hyebin Kim, Prof. Elanor Williams, Prof. Mary Steffel

When and Why Decisions for Joint Consumption Elicit Anxiety
» Prof. Sharaya |ones, Prof. Margaret Campbell

Splitting the Bill in Shared Consumption
» Prof. Nicole Kim, Prof. Ximena Garcia-Rada, Prof. Rebecca Ratner

4.06 Roundtable - A/B Testing in Marketing Research

Ravenna
Chaired by: Dr. Uri Barnea
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2:30pm

2:30pm

A/B Testing in Marketing Research

» Dr. Uri Barnea, Dr. Johannes Boegershausen, Dr. Michael Braun, Dr.
Yann Cornil, Dr. Wendy De La Rosa, Prof. David Hardisty, Dr. Dan
Schley, Dr. Shalena Srna, Prof. Joachim Vosgerau

4.07 Perception Unleashed: Exploring Sensory Influences on
Consumer Behavior

Aspen

Chaired by: Dr. Laura Boman

2:30pm

| Tipped, So I'll Be Back!: How Pre-Service Tipping Impacts
Anticipated Taste and Repatronage Intentions

» Dr. Laura Boman, Dr. Ismail Karabas

Exploring the Minimalism-Avoidance Effect in Gift Giving
» Dr. Dongjin He, Dr. Linying (Sophie) Fan, Prof. Yuwei Jiang

Effects of Color Saturation on Perceived Product Performance
» Ms. Krissa Nakos, Dr. Marcus Cunha Jr., Dr. Sokiente W. Dagogo-Jack

Paralanguage and the Charismatic Spokesperson: The Impact of
Vocal Amplitude and Pitch on Customer Engagement

» Dr. Christine Ringler, Dr. Nancy Sirianni

4.08 Whispers of Influence: Examining Word-of-Mouth Dynamics in
Consumer Choices

Columbia

Chaired by: Prof. Leilei Gao

When the Irrelevant Becomes Relevant: The Impact of Small Talk 2:30pm
on Consumer Engagement with Livestreamers

» Prof. Xiaomeng Fan, Dr. Tingting Fan, Ms. Ting Guo, Prof. Cindy
Fengyan Cai, Prof. Leilei Gao, Prof. Yael Steinhart

Powered by Ex Ordo, everything you need to run a research conference.

Rejected Recommendations Reduce Recommender Repurchase of
a Previously-Recommended Product

» Dr. Matthew Hall, Dr. Jamie Hyodo, Dr. Kirk Kristofferson

The Effect of Inconsistent Reviews on Consumer Memory
» Dr. Alican Mecit, Dr. Ana Scekic, Dr. Aradhna Krishna

Metaphysical Deterrents to Providers’ Participation in the Sharing
Economy: The Role of Peer-to-Peer Contagion

» Mrs. Ipek Ozer, Mrs. Ana Valenzuela, Ms. Maria Galli

4.09 Decoding Consumer Realities: Exploring Embodied Rationality,
Axiological Nostalgia, Rural Place Branding, and Stigmatized
Consumption

Seneca
Chaired by: Mr. Jan-Hendrik Bucher

Consumer experiments: An embodied approach to lay-rational
decision-making

» Mr. Jan-Hendrik Bucher, Prof. Johanna Gollnhofer

Value-creating processes of past-themed marketing and
consumption

» Mr. Christian Dam, Dr. Benjamin J. Hartmann, Dr. Katja H. Brunk

Place branding and cultural intermediaries representations: a
socio-semiotic approach

» Ms. Paola Gioia, Dr. Nacima Ourahmoune, Mr. Diego Rinallo

“The civilizing consumption etiquettes: Understanding
internalization of stigma in a stigmatized-wellbeing consumption
context”

» Dr. Arti Srivastava, Dr. Rajesh Nanarpuzha, Mr. Prakash
Satyavageeswaran, Prof. Chris Dubelaar

4.10 Decoding Food Perception and Behavior: From Nutrition
Numbers to Sharing Dilemmas

Boren
Chaired by: Dr. Nuoya Chen
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2:30pm

BEHIND 280 CALORIES: UNDERSTAND THE NUTRITION FACTS LABEL
BY INTELLIGIBLE UNITS

» Dr. Nuoya Chen, Dr. Huixin Deng, Dr. linfeng (Jenny) liao, Prof.
Xiucheng Fan

2:30pm

How People (Falsely) Learn that Healthy Food is Less Tasty
» Ms. Eda Erensoy, Dr. Bradley Turnwald, Prof. Ayelet Fishbach

Unpacking Consumer Reactions Towards Spoilage of Organic
versus Conventional Perishables

» Dr. Tim Ozcan, Dr. Ahmet Hattat

Hesitance to share suboptimal food due to predicted negative
reactions from recipients

» Ms. Yi Zhang, Dr. Erica van Herpen, Dr. Mario Pandelaere, Prof.
Maggie Geuens

4.11 Human-Robot Interaction and Identity in the Age of
Technology: Personalization, Perception, and Preference

Greenwood

Chaired by: Dr. Chi Hoang

Loss of Control: How Interactions with Robots Reduce Consumers’ 2:30pm
Willingness to Pay

» Dr. Chi Hoang, Dr. Xiaoyan (Jenny) Liu, Dr. Sharon Ng

Lexie knows me better! Nicknaming Virtual Conversational
Agents and the Effects on Personalization Perceptions

» Ms. Bianca Kato, Dr. Juan Wang

3:45pm

Product customization for “human-affirmation”: Consumer
exposures to autonomous agents increase preference for
customization

» Dr. Hyeyoung Kim, Dr. Ann L. McGill

4pm

Powered by Ex Ordo, everything you need to run a research conference.

“Smartphone Reduces Thoughtfulness” Intuition: How
Smartphone Use Decreases Decision-Making Confidence

» Ms. Vincentia Yuen, Dr. Claudia Townsend, Prof. Michael Tsiros

4.12 Special Session - How Language Shapes Persuasion
Redwood A&B
Chaired by: Dr. Wenyan Yin

Personal Pronouns and Persuasion
» Dr. Wenyan Yin, Prof. Jonah Berger, Dr. Yanliu Huang

The Effect of Linguistic Subjectivity and Objectivity in Online
Reviews: A Convolutional Neural Network Approach

» Dr. Sang Kyu Park, Mr. Taikgun Song, Dr. Aner Sela

The Upside of Defeat: Failure Stories Are (Surprisingly) Persuasive
» Dr. Anne Hamby, Dr. Brent McFerran, Prof. Darren Dahl

Thanks, But No Thanks: How Firms Should Respond to Positive
Word-of-Mouth

» Dr. Katherine Lafreniere, Prof. Sarah G. Moore, Dr. Mohamad Soltani

4.13 Plenary - Uncovering Consumer Insights while Protecting
Consumers’ Rights - A Policy Perspective

Metropolitan B
Chaired by: Dr. Maura Scott

Coffee Break
Grand Ballroom PFA

Yoga
Everett
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4pm

4pm

5.01 Special Session - Breaking New Ground with Generative Al:
Insights from Consumer Research

Cedar
Chaired by: Dr. Melanie Clegg

4pm

When Using ChatGPT, | Am Collaborating, but You Are Outsourcing
» Ms. Begum Celiktutan, Dr. Mirjam Tuk, Dr. Anne-Kathrin Klesse

When Al Generates Rules: Consumer Compliance and the Role of
Perceptions of Justice

» Dr. Valentina Pitardi, Dr. Ana Valenzuela

Al-Powered Market Research: Conversational Al Reduces How
Much Consumers Express Themselves

» Ms. Meike Zehnle, Dr. Christian Hildebrand, Dr. Gizem Yalcin

Al Creativity: How Solution Dissimilarity Harms Al Usage and Idea
Selection

» Dr. Melanie Clegg, Mr. Marc Bravin, Prof. Reto Hofstetter, Prof.
Christoph Fuchs

5.02 Special Session - The Great Deception: Disentangling Fact from
Fiction in the Era of Misinformation

Issaquah
Chaired by: Mr. Amin Shiri 4pm

Don’t Trust What You See: The Effect of Deepfake Videos on
Consumer Evaluations

» Mr. [eremy Fannin, Prof. Gita Johar, Prof. Tobias Schlager

Harnessing Polarization to Combat Misinformation
» Mr. Cameron Martel, Prof. David Rand, Ms. Jennifer Allen

Did Fox News Really Try to Persuade People Not To Get Vaccinated
Against COVID-19?

» Dr. Chuck Howard, Dr. Buffy Mosley, Mr. Ty Longmire-Monford

Powered by Ex Ordo, everything you need to run a research conference.

Faith in Falsity: Why "Fake" Labels Resonate More Than Verified
Truths

» Mr. Amin Shiri, Prof. Keith Wilcox, Dr. Xiang Wang

5.03 Morality in the Marketplace: Unpacking the Ethical Consumer's
Dilemma

Jefferson
Chaired by: Mr. Yugi Guo

Warm Glow Cools Off: Long-term Usage Reduces Ethical Product
Choices

» Mr. Yuqgi Guo, Ms. Ceren Sahin, Dr. Robert Smith, Dr. Anna Paley

Accepting Cryptocurrency as a Form of Payment Undermines
Brand Evaluations

» Mr. Han Young Jung, Mr. Shih-Chun Chin, Dr. Sarah Lim, Dr. Kathleen
Vohs

Addictive Ad Aversion: The Backfiring Effects of Marketing Foods
as Addictive Substances

» Dr. Maria Langlois, Dr. Alixandra Barasch

Won't You Be My Neighbor: Effects of Vigilantes on Consumers'
Attitudes Toward Neighborhoods and Local Businesses

» Dr. Lily Lin, Dr. Maja Graso, Dr. Karl Aquino

5.04 Special Session - How Confidence Shapes Language and
Behavior

Willow A
Chaired by: Dr. Matthew Rocklage

The Trajectory of Confidence: Experience, Certainty, and
Consumer Choice

» Dr. Matthew Rocklage, Prof. Jonah Berger

Parroting in Word of Mouth: Do More Certain Transmitters
Generate Less Certain Receivers?

» Prof. Ann Kronrod, Dr. Yakov Bart
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4pm

4pm

Not All is Written in the Stars: When and Why One-Star Ratings
Lead to an Increased Purchase Likelihood

» Dr. Bowen Ruan, Dr. Taly Reich, Dr. Min Tian

The Language of (Non)Replicable Science

» Dr. Michal Herzenstein, Ms. Sanjana Rosario, Mx. Shin Oblander, Dr.
Oded Netzer

5.05 Special Session - Emotional Appeals in Brand Communication:

When Are They Successful?
Willow B
Chaired by: Dr. Ishita Chakraborty

The Importance of Shared Experience in Consumer Reactions to
Empathy-based Advertisements During a Crisis

» Ms. Neha Nair, Dr. Craig Brimhall, Dr. Eric VanEpps, Dr. T. Bradford
Bitterly

Impressive Insults: Examining the Effect of Self-Deprecating Ads
on Consumer Perceptions

» Ms. Vaishnavi Kale, Dr. Eda Sayin

How and Why Empathy Matters for Brand Communication: A
Large-Scale Experimentally Validated Empathy Detection Model
from Tweets

» Ms. Keziah Kim, Dr. Ishita Chakraborty, Dr. Nupur Giri, Dr. Mansur
Khamitov

5.06 Roundtable - Sharing Good Well
Ravenna
Chaired by: Dr. Laura Schrier Rifkin and Prof. John Costello

Powered by Ex Ordo, everything you need to run a research conference.

4pm

4pm

A

Sharing Good Well
» Dr. Laura Schrier Rifkin, Dr. Aleksandrina Atanasova, Dr. Russell Belk,

————————————————————————————————————

Dr. Susan Broniarczyk, Prof. John Costello, Dr. Colleen Kirk, Dr. Cait
Lamberton, Dr. Sarah Moore, Prof. Linda Price, Prof. Karen Page

Winterich

5.07 The Time Has Come: Examining Temporal Effects, Social
Functions, and Purchase Intentions

Aspen
Chaired by: Mr. Su Young (Kevin) Choi

Can | make the time or is time running out? The role of
metacognitive experiences of difficulty

» Mr. Su Young (Kevin) Choi, Dr. Daphna Oyserman

So Cute, | Could Wait: The Effect of Cuteness on Consumer
Patience

» Ms. Xiaoran Wang, Dr. Xiadan Zhang, Dr. Jing Jiang

Product arrangements: Are Time and Number in sync?
» Prof. Sanjeev Tripathi, Mr. Abhishek Jha

Impatience Over Time
» Dr. Annabelle Roberts, Prof. Ayelet Fishbach

5.08 Amplifying Word of Mouth: Triggers, Cues, and Conversations
Columbia
Chaired by: Dr. Aleksandra Kovacheva

Let’s Speculate About It: When and Why Uncertainty Increases
Word of Mouth

» Dr. Aleksandra Kovacheva, Dr. Hillary Wiener

Your Friends Make Your Review More Persuasive: The
Informational Value of Joint Consumption Cues as Social
Endorsement in WOM

» Ms. Menglu Dong, Prof. LiLi Wang, Prof. Yuwei Jiang
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4pm

4pm

I Liked It Before It was Cool: How Marketers Can Leverage
Adoption Timing to Encourage Word of Mouth

» Mr. Cory Haltman, Dr. Grant Donnelly, Prof. Rebecca Reczek

Signal of Recovery: The Mere Signal of the Presence of Private
Manager Response as eWOM Intervention Strategy

» Ms. Vincentia Yuen, Prof. Michael Tsiros

5.09 Embracing Perspectives: Qualitative Explorations of Consumer
Aspirations, Legitimization, Stereotypes, and Body Interpretations

Seneca
Chaired by: Dr. Lena Cavusoglu

The ugly truth: Diversity perspectives of fashion professionals
» Dr. Lena Cavusoglu, Dr. Danielle Sponder Testa

Emancipation from passive bystander to active market creator -
Consumers’ role in the legitimization process of controversial
products

» Ms. Verena Riegler, Prof. Daniel Wentzel

The Draw-And-Tell-Your-Story Method to Understand
Consumption Stereotypes in Children

» Ms. Tabitha Thomas

Towards a Continuum of Consumer-Body Relationship:
Interpreting the Fat Body

» Mrs. Vidushi Trivedi

5.10 Embracing Race: Consumer Perceptions and Actions in a
Diverse Landscape

Boren
Chaired by: Mrs. Nicole Davis

Powered by Ex Ordo, everything you need to run a research conference.

4pm

4pm

The Effects of Anti-Bias Training in Doctor Selection

» Mrs. Nicole Davis, Dr. Broderick Turner, Prof. Esther Uduehi, Dr.
Andre Martin

Racial Discrimination and Anti-Discrimination: The COVID-19
Pandemic’s Impact on Chinese Restaurants in North America

» Dr. Chuang Tang, Dr. Shaobo Li

Privileged And Picky: How Entitlement Impacts Product
Acceptance Range of Advantaged vs. Disadvantaged Consumers

» Mr. Bryce Pyrah, Dr. Chelsea Galoni, Dr. Alice Wang

Ingroup Favoritism or Aversion? The Discriminatory Role of Racial
Congruence in a Two-Sided Platform

» Ms. Xiu Wu, Dr. SunAh Kim, Dr. Ohjin Kwon, Dr. TaeWoo Kim

5.11 Money Matters: Insights from Credit, Consumption,
Cryptocurrency, and Debt Interventions

Greenwood
Chaired by: Dr. Farah Diba Abrantes-Braga

Credit Card as an Inclusion Instrument of Low-Income Consumers

» Dr. Farah Diba Abrantes-Braga, Dr. Danny C Claro, Dr. Julio Trecenti,
Dr. Nancy Wong

Quality-Quantity Tradeoffs in Consumption
» Mr. Rodrigo Dias, Dr. Eesha Sharma, Prof. Gavan Fitzsimons

The Moral Foundations of Cryptocurrency
» Dr. Sachin Banker, Dr. Joowon Park, Dr. Eugene Chan

The Additional Grace Period Effect
» Ms. Gayoung Park, Prof. Rajesh Bagchi

5.12 Special Session - Methods in Practice: How Statistical
Understanding Affects Marketing Decisions and Outcomes

Redwood A&B
Chaired by: Dr. Antonia Krefeld-Schwalb
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Does Big-Data Correlational Analysis Predict Causal Effects of
Language on Decisions?

» Dr. Akshina Banerjee, Dr. Oleg Urminsky

The Big Data Fallacy.
» Prof. Irene Scopelliti, Prof. Joachim Vosgerau, Dr. Gaia Giambastiani

Control Group Neglect
» Dr. Guy Voichek, Prof. Ravi Dhar, Prof. Shane Frederick

Selective Reporting in Market Research

» Dr. Gabriele Paolacci, Dr. Sara Costantino, Prof. Antonia Krefeld-
Schwalb

4pm JCR AE Meeting (Invite Only)
Capitol Hill

5:15pm Co-Author Meetings + Well Wish Cards
Grand Ballroom PFA

5:15pm JCR ERB Meeting (Invite Only)
Metropolitan A

6:30pm Working Paper Reception (Sponsored by NYU Stern School of
Business)

Grand Ballroom ABCD + Grand Ballroom PFA

Powered by Ex Ordo, everything you need to run a research conference.

Mitigating Information Asymmetry in Two-Sided Markets

» Ms. Esther |. Kim, Dr. Helen Chun, Dr. Sunghan Ryu, Dr. Joonhyuk
Yang

Logo Shape's Effects on Perceived Brand Premiumness and Brand
Preference

» Ms. Ruigin Li, Dr. Yan Wang

The effect of visually complex packages on virtue/vice perception
and evaluations of products

» Mr. Zhihong Huang, Dr. Eunsoo Baek, Dr. Seojin Stacey Lee

Age Differences in Medical Crowdfunding
» Ms. Xupin Zhang, Ms. Bingxiang Ji, Dr. Silvia Sérensen

Research on the Influence of Danmaku Interaction Characteristics
on Sales Efficiency in E-commerce Live Streaming

» Ms. Liangbo Zhang, Mr. Zean Pan, Ms. Xinyu Wu, Dr. |ifan Ren

Truly Inconspicuous Consumption: A Review and Critique of the
Literature on Status Consumption in Marketing

» Mr. Brandon Christensen

Consumers’ Responses to Personalized Service from Medical
Artificial Intelligence and Human Doctors

» Ms. Yiran (Eileen) ZHANG, Ms. Wenying TAN, Prof. Eunju LEE

Diversity Marketing and Colorism Bias in East Asian Consumer
Segments

» Dr. Julian K. Saint Clair, Mr. Tristan Lee

Cigarette Smoking, Addiction, and Gender: Insights from the
Tobacco Industry’s Consumer Research

» Prof. Timothy Dewhirst, Prof. Wonkyong Beth Lee

Consumers’ Reactions to Internet Marketing with Memes
» Dr. Lu Wang, Dr. Shirley Li, Dr. Lei Su
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Therapeutic Entrepreneurship and Consumer-Led Market
Formation

» Mr. SILA AYOZ

Chronotype Equity and Wellbeing; Are We Biased Towards
Morning Types and Against Evening Types?

» Dr. Pramit Banerjee, Mr. Shashi Minchael

Mixed Blessing: The Effects of Innovative Changes of Video Game
Sequel on its Market Performance and Brand Community

» Mr. Zhigiang Li, Ms. Yaxuan Ran, Dr. Jiani Liu

Losing Yourself to Others: How Morally-Incongruent Everyday
Purchases for Others Impact Consumers and their Relationships

» Ms. Cindy G. Grappe, Dr. Jennifer J. Argo, Dr. Sarah G. Moore

Uber and Taxi Industry : How Digitalization and Platforms Affect
Traditional Markets

» Mr. SILA AYOZ

Can | be Back in the Group? The Chance for Reaffiliation Impacts
Socially Excluded Consumers’ Preferences for Scarce Products

» Dr. Nari Yoon

A Matter of Time: The Impact of Lateness on Consumer Judgments
» Ms. Raina Zhang, Prof. Priya Raghubir

Few Opportunities and High Consistency: How Individualism-
Collectivism Moderates the Effect of Al Interviews on Job Seekers'
Reaction

» Dr. Zhongzhun Deng, Dr. Yongchao Ma

Effortlessly Digital: Giver-Receiver Discrepancies in the Desire for
Digital and Physical Gifts

» Dr. Oden Groth, Dr. George E. Newman, Dr. Lauren Block
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Mindful Food Consumption by Children at School Cafeterias:
Findings from a Field Study

» Ms. Mikyoung Lim, Dr. Annika Abell, Dr. Courtney Szocs, Dr. Dipayan
Biswas

Bonding Through Play: When Effort Makes Serious Play
Meaningful

» Ms. Xuan Xie, Dr. Sayantani Mukherjee, Dr. Loraine Lau-Gesk

Nature is Short-lived? The Effect of Naturalness Cues on Perceived
Durability of Products

» Ms. Menglin Li, Ms. Weiyi Li

Time Is Money? How Time (Money) Activation and Self-Regulatory
Focus Impact Consumers’ Disaster Preparedness

» Dr. Yuanyuan (Gina) Cui, Dr. Patrick van Esch

Consumers’ Brand Engagement on Social-TV: Insights on
Sentiment and Intention to Engage

» Dr. Sahana Sen, Dr. Michele Gorgoglione, Dr. Umberto Panniello

Brand Associations Can Produce Implicit Trademark Infringement
» Prof. Claudiu Dimofte

The Advantage of Feminine Brand Cues: Female Brands are
Perceived as More Sustainable

» Ms. Aybike Mutluoglu, Dr. Ekin Ok, Dr. Nicole Robitaille, Prof.
Laurence Ashworth, Ms. Emma Vanlerberghe

Splitting the Bill Later Inhibits Social Relationships
» Mr. WENJIE HAN, Prof. Jacqueline Rifkin

When Experts Rate the Potential of “Spreading Good”: Comparing
Feasibility Considerations of Electric Roadways Between 2020 and
2023

» Mr. Jae Lee, Mr. Tyler Rich, Dr. Antje Graul, Prof. Regan Zane
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Rethinking Weight Stigmatization and its Impact on Charitable
Giving
» Ms. Lacey Wallace, Dr. Abhi Bhattacharya

The Influence of Gender on Money'’s Perceived Value
» Ms. Aybike Mutluoglu, Prof. Laurence Ashworth

Daily Average vs. Weekly Total: The Effect of Screen Time Framing
on Consumer Self-Control Intention

» Dr. Mijin Kwon, Prof. Youngjee Han, Prof. Hakkyun Kim

ONTOLOGICAL INSECURITY AND CONSUMER RESISTANCE TO
NOVEL AND TRANSFORMATIVE CONSUMPTION

» Dr. Kamal Ahmmad, Dr. Elizabeth Howlett, Dr. Kunter Gunasti

Bilateral Asymmetry: Consumers Have Genetically-Determined
Preferences for Asymmetry And Socialized Preferences for
Symmetry

» Mr. Tyler Basara, Dr. Martin Reimann

When Al and Consumers Service Encounter Go Wrong: Attribution
of Causality and Consumer and Firm Outcomes

» Mrs. Alessandra Lisanti

Why go solo? Autonomy and competence as drivers of solo
experience preference

» Ms. Zuzanna |urewicz, Dr. Kirk Kristofferson, Prof. Miranda Goode

Connecting with Your Customers via Metaverse Store Designs:
Testing Virtual Store Designs to Convey Brand Personality

» Dr. Andy |eon, Dr. Yao Sun

Power Concerns as a Source of Response Bias in Vertical
Individualistic Cultures: Implications for Sales Influence Attempts

» Ms. Alaa Eldemerdash
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The Scarce = Natural Intuition
» Ms. Dan Liu, Prof. Xiaobing Xu

Framing influences donation behavior by altering the process of
information acquisition

» Dr. Nitisha Desai, Prof. Scott Huettel

Health Inequity Implications of Digital Health Interventions (DHI)
Adoption

» Dr. liang Qian, Ms. Sakshi Singh, Dr. Meng Zhu

The Importance of Interaction While Utilizing a Digital Avatar for
Shopping

» Ms. Tanishka |ain, Prof. Joann Peck

How location affects marketing success on Social Media: where
you watch an ad matters

» Ms. Xiaozhi Yang, Mr. Colin Eles, Mr. Yozen Liu, Dr. Maarten Bos, Dr.
Ron Dotsch

Philanthropy vs. Functionality: The Impact of Cause-Focused
Information on Purchase Intention for Social Enterprises

» Mrs. Emma Gibbons, Dr. Pallav Routh, Dr. Bonnie Simpson, Dr.
Suman Basuroy

Should I Accept a Pay Cut for You to Get a Raise? The Dynamics of
Increasing Inequality in Couples

» Ms. Tong Su, Prof. Shoham Choshen-Hillel, Prof. Ayelet Fishbach

Passion as an Excuse: Perceived Passion and Audience
Forgiveness

» Ms. Yeonjin Sung, Dr. Mijeong Kwon

What Drives Gastronomic Experiences in Luxury Brands? The
Effect of Cultural Differences on Costly Signals

» Ms. Sanghee Kim, Prof. Leslie Cuevas, Prof. Hyo Jung (Julie) Chang
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Breaking the Monopoly: How Multiple Identities Drive Consumer
Movements

» Mr. Mohd Suhaimi

The Impacts of Price and Display Complexity on Plant Purchase
Intention: An Eye-tracking Study

» Dr. Jie Li, Dr. Bridget Behe, Dr. Patricia Huddleston, Dr. Scott Thatcher

Does “Falcon” or “Batman” in Advertising Help? Investigating the
effects of reverse-anthropomorphism.

» Mr. Youngdai Won, Dr. Chen Wang

Safeguarding Consumer Health: Inoculating Against Misleading
Alternative Medicine Advice

» Dr. Dominique Braxton, Ms. Oluwafikayo Iredele

A Program of Research on Age Related Effects in Processing and
Responding to Pharmaceutical Marketing Communications

» Ms. Shiyun Chen, Prof. Cathy Cole, Prof. John Murry

Breaking down the FINTECH—How Science Literacy and
Investment Profitability Jointly Influence Cryptocurrency
Investment Intentions

» Mr. Heshan Dong

Unwanted Consequences of Political Consumption
» Ms. Xin Zhou, Dr. Monika Lisjak, Dr. Neeru Paharia

Under influence of the influencer: what mechanism explains an
influencer’s influence on consumers’ product evaluations?

» Dr. Even Lanseng

Sexual primes triggering gender stereotypes: Implications for
consumer behavior

» Dr. Delane Botelho, Prof. RAMONA DE LUCA, Dr. Vitor Azzari

Powered by Ex Ordo, everything you need to run a research conference.

You can't buy ethicality: The modality of creation impacts the
reputational benefits of inclusive design.

» Ms. Aprajita Gautam, Dr. Julie Irwin, Prof. Rebecca Reczek

Do robots dream in color? The effect of human versus robots in
retailing

» Dr. Duygu Akdevelioglu, Dr. Dominique Braxton, Dr. Selcan Kara

When touching is sincere but looking is sophisticated: The
congruence between brand personality and sensory imagery
influencing consumers responses.

» Mr. Christian Arroyo

When Known Brands Should Think Twice About Disabling
Comments

» Mr. Dustin Wilcox, Dr. Ismail Karabas, Dr. Yana Andonova

Photo Filtering Filters Consumers’ Perceptions of Others’
Experiences and Our Own Memories For Past Events

» Ms. Stephanie Hong, Dr. Kristin Donnelly

Fate, Forgiveness, and Brands: How Karmic Belief Impacts
Consumer Attitudes towards Transgressions

» Dr. Kylie Vo, Dr. Yuna Choe

ERROR COST VERSUS ERROR PROBABILITY IN CONSUMER CHOICE
» Dr. Even Lanseng

Political Ideology Shapes Preferences for Material and
Experiential Purchases

» Ms. Yujin Lee, Dr. Joshua Clarkson, Mr. Alberto Barchetti

Meaning Transfer of Dead Celebrities: The Frida Phenomenon
» Dr. Geraldo Matos, Dr. Cecilia Ruvalcaba, Dr. Delancy Bennett

Risky crypto: The effect of cryptocurrency as payment method on
trust in consumer-firm relationships

» Mr. Philipp Winder, Dr. Christian Hildebrand
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Belief Formation in Turbulent Times: The Role of Deliberation in
Navigating Uncertainty

» Ms. Mahsa Faridmehr, Prof. Selin Atalay

Acculturation in situ: How trigger-city marketing forms
consumers’ taste

» Ms. Adis Maulidina, Dr. Sorush Sepehr

How to frame messages to encourage sustainable brand
consumption: focusing on the role of individual’s perceived
socioeconomic status

» Ms. Mikyoung Lim, Mr. junghan chung

I (Don't) Compare, When | Am (In)Capable: The Inverse U-Shape
Effect of Top Donation on Subsequent Donations in Medical
Crowdfunding

» Dr. JOYCE (FENG) WANG, Dr. Fei Gao, Ms. Elena Elkanova

Understanding Responses to Stereotypes in Ads

» Ms. Elizabeth liang, Dr. Margaret Shih

Beyond the Default: Exploring the effects of displaying default
medical treatments in Advance Care Planning

» Ms. Brianna Chew, Dr. Ariel Fridman, Dr. Ayelet Gneezy

Technological Affordances and the Social Construction of Scarcity
in the Non-Fungible Token (NFT) Market

» Ms. Uyen Phan, Dr. Andrew Smith

How does Social Connectedness Affect Socially Responsible
Consumption?

» Ms. Nasrin Yazdanian, Dr. Bianca Grohmann, Dr. Onur Bodur

Consumer Ambiguity and Skepticism: Interacting with Brands’
Paradoxical Identity during the Age of Catastrophe

» Dr. Asfiya Taji, Dr. Eric Li

Powered by Ex Ordo, everything you need to run a research conference.

The Effect of Uncomfortable Temperature on Green Consumption:
The Mediating Role of Perceived Resource Scarcity

» Ms. Qi Cao, Dr. Xiang Fang, Prof. Xiaoyu Wang, Dr. Yuechen Wu

Vulnerability Effect: More Vulnerable, More Expensive?
» Prof. Xiaoying Zheng, Mr. Yixuan Liu

Giving because | want to, not because | have to: The effect of
social context on donations

» Dr. Katina Kulow, Dr. Kara Bentley, Prof. Priyali Rajagopal

Technology and Time in Greenwashing Discourses - The Case of
the Fast Fashion Industry

» Ms. Chrysa Gkotsi, Dr. Thomas Robinson

Quid Pro Quo: How Consumers Leverage Brand Loyalty to
Increase Access to Scarce Products

» Dr. Katina Kulow, Dr. Kara Bentley, Prof. Priyali Rajagopal

Shattering the Glass Ceiling of Healthcare Disparities: The
Transformative Power of Culturally Sensitive Care

» Dr. Melika Kordrostami, Dr. Maryam Tofighi

How Emotional Content and Engagement Contribute to Audience
Growth

» Dr. Begum Sener, Dr. Bruce Dore

Traditional or Novel, Hopeful or Anxious: Consumers' Dilemma of
Novelty

» Ms. Busra Kilic, Dr. Emilia Cubero Dudinskaya, Prof. Simona Naspetti,
Prof. Raffaele Zanoli

Curiosity Killed the Cat, but it Can Bring Life to Charitable
Donations: An Investigation into the Power of Piquing and
Resolving Curiosity.

» Mr. Alexander Hanson, Dr. Nate Martin, Dr. Adam Farmer
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When the End is Near: How Hitting Pan Affects Product Evaluation
and Repurchase Intention

» Ms. Xinwei Liu, Prof. Qin Wang, Dr. Haley Hardman

Portfolio of Donations: Giving to More When Feeling Less Powerful
» Dr. Mina Kwon, Dr. Katina Kulow, Dr. Mike Barone, Dr. Joseph Neary

The Power of Packaging: How Shape Affects Consumer Perception
of Organic Products

» Dr. GIULIANA ISABELLA, Ms. Carlos Jose Salgado-Rohner

I Skip Ad and | Don’t: Dual Influence of Offline and Online
Personalities on Skippable YouTube Advertisement

» Dr. Andy |eon, Dr. Yuhosua "Josh" Ryoo

Oh no! that was too sudden: Role of Sudden Product-Failures in
Repair-Intentions

» Prof. Aruna Tatavarthy, Prof. Nidhi Agrawal

Spatio-temporal associations of Covid-19 severity, well-being, and
risk attitudes

» Dr. Felix Jan Nitsch, Ms. Marie Falkenstein, Prof. Aiging Ling, Prof.
Tobias Kalenscher, Dr. Hilke Plassmann

Status Threat and Inter-Generational Compensatory
Consumption: The Impact of Parents’ Status Threat on Children-
Improvement Products

» Ms. Wenxue Zheng, Prof. Xiaoying Zheng, Dr. Zhiyong Yang, Prof.
Siging Peng

Self-other or other-in-self: individual and dividual self in peer-to-
peer accommodation sharing

» Dr. Jashim Khan, Dr. Russell Belk

How Racial Composition Influences Advertising Outcomes
» Dr. Kelly Cowart, Dr. Zhihao Yu, Mr. Aihui Ding

Powered by Ex Ordo, everything you need to run a research conference.

The multiple-identity effect: Multiple social identities shape how
time is perceived

» Ms. Menglin Li, Dr. Sheng Bi, Dr. Huan Chen

Bigger is not always better: Brand name length, attitude and
recognition

» Mr. |esse Zee, Prof. Malaika Brengman, Prof. Timothy Desmet, Prof.
Kim Willems

Fake News and the Need for Approval: Understanding the Act of
Sharing

» Dr. Eduardo Mesquita, Dr. Evandro Luiz Lopes, Dr. GIULIANA
ISABELLA

How Consumers with Hedonic (vs. Utilitarian) Purchase Motive
Use Item-Price (vs. Price-ltem) Presentation Order as a
Mechanism to Justify Their Hedonic Purchase

» Dr. Jungsil Choi, Dr. Hyun Young Park

Uncovering the Personality of Human Brands: Exploring the
Power of Deep Learning in Natural Language Processing

» Ms. Leila Yousefi, Dr. SunAh Kim

Multisensory Components of Norwegian Authentic Eating
Experiences: A Mixed-Methods Approach

» Dr. Huy Tran, Dr. Tuan Do, Prof. Nina Veflen, Prof. Carlos Velasco

Speed Down, Fresh Up: How Food Movement Speed in Advertising
Videos Influences Freshness Perception

» Ms. Yehui LIU, Mr. Lu MENG, Dr. Shaobo Li, Prof. Yuwei Jiang

Self-confident masculinity can increase, not decrease, vegan
consumption

» Ms. Mailin Struck, Dr. Hugh Wilson, Dr. Miaolei Jia, Dr. Isabel Ding

Charity in the Marketplace: Charitable Giving as a Struggle for
Resonance

» Prof. Gregorio Fuschillo, Prof. Simona D'Antone
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The Determinants of Customer Incivility in Service Context
» Ms. Skylar Kim, Ms. Esther J. Kim, Prof. Robert Kwortnik

Diversity in Luxury Brands reduces White Consumers' Perceptions
of Exclusivity

» Dr. Jorge Jacob, Ms. serena Paille, Ms. flore auvergnon, Ms. rand
aljunaidy

Taste is Influenced by Individualizing Moral Concerns - A
Controlled Sensory Laboratory Experiment on the Taste of Moral

» Dr. Nadine R. Gier, Ms. Regina Harms

Sneaking into a Cinema Without Buying a Ticket: How Metaphor
Reduces Piracy

» Ms. Hongyu Meng, Dr. Tianjiao Yu, Prof. Jun Ye

The Push-Pull-Mooring Model of Service Switching: A Meta-
Analysis

» Mr. Tobias Marx, Ms. Regina Harms, Ms. Lara Frébel

The Effects of Anthropomorphized Chatbot and Compensation
Type on Service Evaluations

» Dr. Eunmi Jeon, Prof. Jaisang(Jay) Kim

Better Early than Late? The Pioneering Advantage of Brand
Activism in Support of Marginalized Groups

» Dr. Maximilian Gerrath, Dr. Kshitij Bhoumik, Dr. Aulona Ulginaku, Dr.
Alessandro Biraglia, Prof. Giampaolo Viglia

Hidden Gem: An Undiscovered Research Gem in Marketing
» Mr. Eldrin Hermoso, Dr. Ulku Yuksel, Dr. Minh-Ngoc Tran

Antecedents of Intention to Adopt Robotic Surgery
» Ms. Sara DallAgnol, Dr. Simoni Rohden, Dr. Mellina Terres

Powered by Ex Ordo, everything you need to run a research conference.

Can verbal frequency estimates be made less sensitive to
contextual distortions?

» Dr. Rahil Hosseini, Dr. Martina Cossu, Dr. Gert Cornelissen

The Role of Source Type and Execution Style in Social Media
Advertising

» Prof. Jun Yan, Ms. lingjing Pan, Dr. Xingyu Wang, Dr. Chao Lei

Do We Treat Others Fairly as We Treat Ourselves? Investigating
the Sunk Cost Bias in Private and Public Settings

» Dr. Hao Sun, Dr. Miaolei Jia, Prof. Zhaoyang Guo

Less is more: Minimalism and WOM behavior
» Ms. Mingrui Song, Dr. Yijun Zhao

Expect More Pleasure: The Impact of Autonomous Sensory
Meridian Response (ASMR) on Product Evaluation

» Ms. Chengchen (Sheryl) Liu, Dr. Yijun Zhao, Prof. Yuwei Jiang

Al-Generated Voice Leaves Consumers Seeking Social
Connections: A Restoration Role of High-Intensity Sensory
Stimulation

» Dr. Yuwei Zhou, Dr. Wei Lu, Dr. Ning Jiang

Antecedents of consumer disclosure : Exploring the role of fluency
and deliberation.

» Ms. Carolina Cuervo Robert, Prof. Sandra Laporte, Prof. Matthieu
Bouvard

The Effect of Political Ideology on Consumer Response to
Employee Agency Control

» Dr. Hung Dao, Prof. Aristeidis Theotokis, Prof. Josko Brakus

Digital Therapeutics : Heralding a new era of marketing in
healthcare & pharmaceutical industry

» Mr. Arnab Kumar Nath, Dr. Ranjitha GP
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Better or Best? How Linguistic Framing Influences the Impact of
Implicit Theories on Next-Generation Products Consumption

» Ms. Nan (Iris) Xue, Mr. Jihao Hu, Prof. Lisa C. Wan, Prof. Robert S.
Wyer

Imagine the future: The role of creativity in consumer response to
brand political activism message

» Ms. Meike Fens, Prof. Donnel Briley, Prof. Jodie Conduit

A Trickle Beats a Gush: How Donation Frequency Impacts
Consumers Responses Toward Philanthropic Brands

» Mr. Jihao Hu, Dr. Tongmao Li, Prof. Miranda Goode

Everyday Consumer Critiques of Brands’ Responsibility Efforts
» Dr. Nicole Yang, Dr. Paolo Franco

When Consumers Stop Spending: The Role of the Left-Digit of
Resources

» Ms. Na Hea Park, Prof. Chan Jean Lee

Swayed Maximizers: The Influence of the Maximizing Mindset on
Reactions to Conditional Promotions

» Ms. Na Hea Park

Creating the “Cinderella effect”: The role of appeal type and
product transformation salience in increasing consumer
acceptance of aesthetically unattractive food

» Ms. Yuli Li, Prof. Nitika Garg

Chosen versus constrained sobriety: How consumers differently
react based on the nature of their sobriety lifestyle

» Ms. Ines Kolli, Prof. Fabien Durif, Mrs. Amélie Guévremont

Heterogeneous Perceived Benefits in Green Luxury Hotel Choices
» Dr. Alex Yao, Mr. Naythan Chan

Powered by Ex Ordo, everything you need to run a research conference.

You MUST buy it: When and when not to be assertive in live
streaming commerce

» Mr. Dingsheng Fu, Prof. Maggie Wenjing Liu

The Negative Influence of Gender-Neutral Initiatives on
Consumer Choice

» Mr. Justin Sieow

The Influence of Logo Variability on Brand Extension
» Prof. Bo Chen

Attention-Catching to the Competitive Advantages: Conspicuous
Product Preference of Consumers in Competitive and Cooperative
Gamified Marketing

» Mr. Yunpeng Shi, Ms. Yayu Zhou, Mr. Haoyuan Wang, Dr. Chunqu
Xiao, Mrs. Fanyue Guo

Goods or Money: How Contribution Amount Influences
Consumers’ Donation Format

» Mr. Ethan (Yunbo) Zhang, Dr. Linying (Sophie) Fan

The unexpected silver lining to seeking meaning through
consumption

» Mr. leremy Lee, Dr. Nicole Mead

Who is Responsible? Differences in Consumer Attributions when
following Algorithmic vs. Human Advice

» Mr. Kevin Jiang, Dr. Ann Schlosser

Sharing autonomy with service robots are satisfying?
» Dr. yajie gao, Prof. Yaping Chang

Consumer Attention and Information Comprehension on Mobile
Devices

» Dr. Joseph Harvey, Dr. Linda Court Salisbury

The Effect of Left-Zero Within Price Numbers: Why $1088 (Vs.
$1188) Would Elicit More Pain of Paying?

» Dr. Wei Li, Prof. Yaping Chang, Dr. Dengfeng Yan, Dr. Han Wang
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On my table, close to me, | can do it: Augmented reality effects on
desirability through concreteness and self-efficacy

» Dr. Juliana Batista, Dr. Ana Valenzuela, Mr. Joseph Koons, Dr. Rhonda
Hadi

The Influence of Consumer Attitudes Toward Time and Well-Being
on Organic Food Consumption

» Dr. Nikki Wingate

From Friends to Firms: Dissecting Consumer Reactions to Time
and Money Requests Across Diverse Relationships

» Mr. Nathaniel Posner, Prof. Vicki Morwitz

Improving the customer experience via automated agents
» Mr. David Goyeneche, Dr. Nicolas Pontes, Dr. Vivian Pontes

Diversity, Morality and Brand Credibility
» Dr. Vivian Pontes

The Effect of Device Type on Shopping Experience
» Prof. Rebecca Chae, Prof. Hyojin Lee

Reducing Hedonic Adaptation By Measuring Hedonic Reactions
Less Frequently

» Ms. Stephanie Hong, Dr. Ed O'Brien

Giver-Recipient Discrepancy in Preference for Group Gifts
» Ms. Zhengyu Shi, Ms. Jiajia Liu, Prof. Echo Wan

Repair Service as a Brand Asset: Quality Signal and Expected
Longevity of Product Usage

» Ms. Ceren Sahin, Dr. Aylin Aydinli

Conceptualizing and measuring the concept of healthy cooking
» Ms. |lennifer Yang, Prof. Joerg Koenigstorfer, Prof. Hans Baumgartner

Powered by Ex Ordo, everything you need to run a research conference.

The Role of Science in Women's Maternity Care Experiences:
Integrating Evidence and Wholeness

» Ms. Natalie Bolen, Dr. Maureen Bourassa

Ideological Poking: Why Consumers Use Outgroup-Offending
Products

» Mr. Matejas Mackin, Dr. Neal Roese

The Effect of Interpersonal Violence Threat on Logo Salience
Preference

» Ms. Liang Shen, Dr. Ryan Rahinel

Here and Now: Accounting for Psychological Distance to Boost
Sustainable Engagement with Digital Technology

» Ms. Yugian Chang, Dr. Xueming Luo, Dr. Zheng Fang

Consumers Overestimate the Impact of Financial Resources on
Others' Preferences

» Mr. Shaaref Shah, Prof. Rebecca Ratner, Dr. Rebecca Hamilton

A Two-Sided Coin: Investigating the Differential Moderating
Effects of Face Consciousness on Luxury Value Perceptions

» Mr. Tim Buchbauer, Ms. Ann-Kathrin Winhuysen

I Do It Better: Self-Construal Moderates Impact of Pride
Expression on Envy Reaction

» Dr. Yang He

Attentional Over-Weighting in Gains, Attentional Under-
Weighting in Losses

» Mr. Brenden Eum, Mr. Stephen Gonzalez, Dr. Antonio Rangel

Maximizing Consumers Glow: When Charitable Giving is
Motivated by More Than Virtue or Status

» Prof. Eleanor Putnam-Farr, Prof. Tracy Rank-Christman

Consumers' Liquid Self
» Mr. Shiekh Shahriar Ahmed
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The role of psychological distance in the evaluation of vegan
products

» Ms. Mailin Struck, Dr. Hugh Wilson, Dr. Miaolei Jia, Dr. Isabel Ding

From Collaboration to Competition: How New Technologies and
Consumers Can Coexist and Thrive

» Ms. Sophia Prix, Ms. Jenny Zimmermann, Prof. Emanuel de Bellis

First come, first served vs. the draw: Which is fair for purchasing a
new product?

» Dr. Jihye Park, Ms. Hannah Kwon

Creative for Me, Ordinary for You: Underestimating Other
Consumers’ Preference for Creativity

» Dr. Brittney Stephenson, Dr. Stephen Nowlis, Dr. Robyn LeBoeuf

Connecting Individual Goals with Group Goals: A Multiple-Goal
Framework

» Ms. Abigail Bergman, Dr. Szu-chi Huang, Dr. Rachel Gershon

Impact of render style on consumer engagement with Virtual
influencers: The moderating Role of controlling entity

» Ms. Liangbo Zhang, Ms. Yingsi Tan, Prof. Guoxin Li, Dr. Xiling Cui, Dr.
Rui Chen, Dr. Jifan Ren, Ms. Zhixuan Liu

Information Search Fulfillment from Online Reviews: Connecting
information Search Behavior Theory to Word-of-Mouth Research

» Mrs. Andrea Pelaez Martinez, Prof. Mahima Hada, Prof. Ujwal
Kayande

Al as a General-Purpose Technology (GPT): Learning from Previous
GPTs to Predict Consumer Perception and Adoption of Al

» Mr. Anush Sridhar, Prof. Emanuel de Bellis
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The impact of product aesthetics on inference-making: How
aesthetics leads to evaluative-consistency reasoning versus
compensatory reasoning.

» Ms. Yujin Lee, Dr. Noah VanBergen

Mind your habits: Exploring the impact of different types of
shopping habits on consumers price sensitivity and healthfulness
of purchase

» Mr. Fares Belkhiria, Dr. Laurette Dube

Risk-Taking to Restore Negative Self-View: Financial Escape from
the Lack of Autonomy

» Dr. Mingyue Zhang, Prof. Haipeng (Allan) Chen

Sacrificial Lifestyle: Disembodiment Through Anti-Consumption
Practices

» Ms. RIYA WADHWANI, Dr. Tanvi Gupta, Dr. Rajesh Nanarpuzha

Moral Expansiveness and the Purpose of Business: A Comparison
of Liberal and Conservative Views

» Dr. Lan Xia, Dr. Shelle Santana, Ms. Wenting Zhong

Hot vs. cold: The effect of color temperature on numeric value
calculation

» Dr. Jihye Park, Dr. Nara Youn, Ms. Hannah Kwon

When the CEO identifies as They/Them. The impact on consumers
evaluation of the brand and the CEO.

» Ms. Valérie Rifenacht, Prof. Bruno Kocher

Leveraging the Social Aspect of Anthropomorphism: Transferring
Employee Creativity to Artificial Agents

» Ms. Lexie HUANG, Dr. Rocky Chen, Prof. Kimmy Chan

What are your pronouns? The impact of choice of identification
on status consumption and self-confidence to complain.

» Ms. Valérie Rifenacht, Prof. Bruno Kocher
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The Impact of Romantic Motive on Consumers' Gift Selection
» Dr. Xueying Zhao, Dr. Dongjin He, Prof. Xinyue Zhou, Prof. Yuwei Jiang

Virtual Avatars on Real Health: The Role of Virtual Influencers in
Health Marketing

» Prof. Zichuan Mo, Ms. Meihan Zhou

When and Why Payment Schedules Fail to Facilitate Consumer
Choice?

» Mr. Haojun Chen, Prof. Sara Kim, Prof. Chu (lvy) Dang

The World is Not Fair: Perception of Income Inequality Shapes
Animal Welfare Consumption

» Dr. Danny |. M. Kim, Dr. Sunyee Yoon, Dr. Jeffrey P. Boichuk

When Do People Stop Non-bound Performance Tasks? Century
Mark Feedback as a Stopping Rule

» Ms. Nulpurum Seo, Dr. Kiju Jung, Prof. Shai Danziger, Prof. Donnel
Briley

Talking Too Much to Be Utilitarian: How Recommender
Talkativeness Shapes Product Perception

» Ms. Cecilia Wu, Prof. Yuwei Jiang

Performance Evaluations for Hybrid Green Products: The Role of
Choice Architecture and Cognitive Style

» Dr. Bryan Usrey, Dr. Charalampos Saridakis, Prof. Aristeidis Theotokis

The Role of Socially Responsible Product Characteristics in
Consumption Deferral

» Ms. Maria |. Ortiz, Dr. Bianca Grohmann

Joy-Laced Sorrow: How Sad Music Positively Impacts Consumers
» Mr. Zachary Plunk, Dr. Blair Kidwell
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Paths to Celebration or Commiseration: Indulgence Alone or
Together

» Ms. Ke Lai, Dr. Kelly L. Haws

How Expressions of Gratitude Influences Psychological Ownership
of Joint Consumption Experiences?

» Mr. Amirreza Faghihinia, Prof. Sarah G. Moore, Prof. Paul R.
Messinger

The Effect of Data Storage Location on Brand Evaluation
» Dr. Sheng Bi, Ms. Weiyi Li, Dr. Jun Pang, Dr. Tianan Yang

All Clear: The Impact of Visibility into Retail Spaces on Shopping
Intentions

» Ms. Elissa Shults, Dr. Stacey Robinson

Evaluation of Multi-functional Products: The Effect of
Anthropomorphism on Cognitive Strain

» Mr. Erik Steiner, Dr. Jing Wan, Dr. Juan Wang

When Solitary Consumption Improves Consumer Experience in
Pursuit of Eudaimonia Goal

» Ms. Nuree Ha, Dr. Onur Bodur

Give me liberty or give me death! the interaction of threat to
freedom, goal conflicts, reactance in product evaluation

» Dr. Na Xiao

Investing for a Sustainable World: Push-Pull-Mooring Factors of
Consumers’ Sustainable Investments

» Ms. Regina Harms, Prof. Tim Eberhardt, Ms. Lara Frébel, Dr. Jan
Spelsiek, Prof. Peter Kenning

The More They Do, the Better? The Role of Crisis Type and
Response Strategies on Attitudes Repair in the Product Harm
Crisis of Live E-commerce Shopping

» Ms. Wenya Guo, Dr. Liya Zhu
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Social fashion identity and sustainability: understanding fashion
disposal behavior

» Ms. Ana |ulia Buttner, Prof. Suzane Strehlau, Prof. Leonardo Vils

Spending with Friends: The Social Labeling of Money
» Ms. Melanie Paul Austin, Dr. Diogo Hildebrand

How Mental Healthcare Platforms Shape Therapy as a Connective
Labor Based Service

» Ms. Ghalia Shamayleh, Prof. Zeynep Arsel

Consumer Responses to Ethical Messages on Animal Cruelty in
Fashion Advertisements

» Ms. Yan Li, Ms. Hanna Shin, Prof. Yoon-Na Cho, Dr. Nara Youn

Don’'t Hate the Haters: Collective Neutralization of Deviance in
Influencer-Focused Anti-Person-Brand Communities

» Dr. Hayley Cocker, Dr. Rebecca Mardon, Prof. Kate Daunt

Why we eat more when choosing vegetarian proteins
» Ms. Sumayya Shaikh, Dr. Amanda Yamim, Dr. Carolina O.C. Werle

It looks work better: Embedding a posture silhouette in medicine
packages to increase purchase intention

» Mr. Zining Wang, Prof. |Jaewoo Park

The Role of Persuasion Knowledge in Driving Reviewing Behavior
for Credence Goods

» Prof. Yu-len Chen

The Effect of Corporate Sociopolitical Advocacy on Moral
Authority and Consumer Engagement

» Dr. Lucia Barros, Prof. Cristiane Pizzutti, Ms. Nathalia Mello, Dr.
Marcos Severo, Dr. Paulo Baptista
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Left On Read: When and Why Ghosting Responses to Digital
Requests for Shared Consumption Persist

» Ms. Grace Zhang, Dr. Grant Donnelly

Storytelling. The key to consumer’s heart

» Dr. Andrea Bazzani, Dr. Silvio Ravaioli, Ms. Alice Nobilio, Prof. Paolo
Frumento, Prof. Ugo Faraguna, Prof. Giuseppe Turchetti

Do squats and salad mix? Self licensing across behavioral domains
» Dr. Anastasia Buyalskaya, Dr. Matthew Shum

Choice Freedom in Donation Decisions: The Influence of Political
Ideology

» Dr. Fang-Chi Lu, Dr. Li-Kuo Sung

Gender Difference in Emotional Responses to Model Body Size
» Ms. Xiu Wu, Dr. Bianca Grohmann

Perceived autonomy of virtual influencers and consumer
reactions

» Dr. Xiaoyun Zheng, Dr. Murong Miao, Dr. Lu Zhang, Dr. Li Huang

Moving On: Implications of “Fresh Start” and “Clean Slate”
Metaphors

» Mr. Sandip Roy, Dr. Robin Coulter

Company-Level Mental Accounting for Investment Returns
» Mr. Eitan Rude, Mr. David Dolifka, Dr. Stephen Spiller

Effects of Surprise Emotion Elicited by Offline Versus Online
Coupons

» Prof. Hiroaki Ishii, Prof. Taku Togawa, Prof. Ikumi Hiraki, Prof. SoonHo
Kwon, Prof. Naoto Onzo

lllusion of Expertise: The Impact of Interacting with Internet-
Based Technologies on Consumer Overconfidence in Purchase
Decisions

» Ms. Yi Su, Dr. Yunlu Yin
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When Green Companies Cultivate Non-Green Consumers: The
Role of Effort Delegation in Pro-Environmental Behavior

» Ms. Yu-Shan Huang, Dr. Xin He

The Interactive Effect of Political Ideology and Perceived
Economic Inequality on Support for Crowdfunding

» Mr. Philippe Wodnicki, Prof. Miranda Goode, Dr. Kirk Kristofferson

“It's a Matter of Perspective”: Extraverts’' Propensity to Mentally
Construe Purchases as Experiences versus Material Objects Brings
Them Greater Purchase-Related Happiness

» Dr. Wilson Bastos, Prof. Fernando Machado

Limiting Accessibility: How Target Market Characteristics
Constrain Acceptable Prices for Innovations

» Dr. Musa Essa, Dr. Johannes Boegershausen, Dr. Gabriele Paolacci

How internalized body-image norms limit the spread of body-
positive messages

» Ms. Fengshu Xie, Dr. Bruce Dore

Innovativeness as a Brand Personality trait: Concept,
Measurement, and Validation

» Dr. Claire-Lise Ackermann, Dr. Blandine Hetet

Text Architecture: How Review Elicitation Format Shapes What
Consumers Say?

» Ms. Riya Sa, Dr. Tatiana Sokolova

A Meta-Analysis on the Effects of Interactive Product
Presentations on Consumer Responses: When and How Do They
Work?

» Ms. Kim Uhlendorf, Prof. Sebastian Uhrich, Prof. Franziska Vélckner
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When Brand Image Meets Al: Investigating Consumer Responses
to Al-designed Products

» Dr. Zhijun Li, Prof. Hong Zhu, Dr. Qingyi Li, Dr. Chunqu Xiao, Ms. Yayu
Zhou

Making Money Rewarding: Conditional versus Unconditional
Pocket Money and Children’s Materialism

» Ms. Ravneet Bawa, Dr. Heather Kappes

Lagging Behind: The Insidious Effects of Brief Internet Delays on
Consumer Engagement

» Dr. Asaf Mazar, Mr. Geoff Tomaino, Dr. Ziv Carmon, Dr. Angela
Duckworth, Dr. Wendy Wood

Breaking the Stigma: The Impact of Chatbot Design on
Consumers’ Willingness to Adopt Healthcare Chatbots for
Stigmatized Health Issues

» Ms. Yuting Pang, Prof. Fangyuan Chen, Prof. LiLi Wang

The Rolling Number Effect: Rolling Display Amplifies Perceived
Numerical Magnitude

» Mr. Junhui Huang, Prof. Maggie Wenjing Liu

When More for You Feels like Less for Me
» Mr. Aaron Nichols, Prof. Nina Mazar, Prof. Remi Trudel

The Benefits of Being Alone: When Solitude Increases Preference
for Self-improvement Products

» Ms. Nuree Ha, Dr. Onur Bodur

Skill and Mindset: Determinants of Consumers’ Attitudes and
Willingness to Purchase Automated Products

» Dr. Suzanne Rath

Digital Human Avatars' Humanity, Heritage, and Aesthetic
Experiences in Metaverse Art Exhibitions

» Ms. Yeon Ju Wang, Dr. Nara Youn
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Let Virtual Creatures Stay Virtual: An Investigation on the Tactics
to Increase Trust in Virtual Influencers

» Ms. Ying Qu, Dr. Eunsoo Baek

Blending the Past and Present of an Old Brand: Why and When
Brand Revitalization and Retro Branding Strategies are Effective
in Heritage Branding

» Prof. Pei-Chi Chen, Prof. Hsuan-Yi Chou, Prof. Cony Ming-Shen Ho

Look before you leap - An empirical analysis on why Dark
Patterns are not (absolutely) beneficial

» Mr. |anis Witte, Prof. Peter Kenning, Prof. Christian Brock

Second-hand Products Consumption: Product Nature Matters

» Ms. Qiangian (Esther) Liu, Dr. Feifei Huang

Effects of Active and Passive Instagram Use on Mother’s Parental
Stress

» Ms. Youngju |ung, Dr. Jung Ah Lee, Ms. Jaeyee Kim, Ms. Yeonsoo Cho,
Prof. Yongjun Sung

You need a good conversation topic: How the human image in
advertisements influences experiential purchases

» Ms. Sining Kou, Mr. Lu MENG, Dr. Yijie Wang, Ms. Yehui LIU

When the active emphasis on blockchain adoption backfires: How
the communication of blockchain adoption influences consumer
purchase intention

» Ms. Sining Kou, Mr. Lu MENG, Dr. Yijie Wang

Product Type Matters: Consumer Preferences for Al versus
Human Recommendations

» Dr. Jooyoung Park, Ms. Daria Gurianova

Veganism as an Ideology Critique: Going Against the Grain for
“Spreading Good...Well”

» Dr. Emre Ulusoy
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Repair or Buy a New One? The Effect of Pursuing Meaning on
Preference for Repairing Products

» Ms. Guilin Liu, Prof. Maggie Wenjing Liu

Smartphone Use Strengthens Price-Quality Inference
» Mr. Xinge Li, Dr. Jintao Zhang, Dr. Yanliu Huang

Does anthropomorphism devalue luxury? The impact of
anthropomorphism on consumers’ evaluations of luxury products

» Ms. Lingling Wen, Prof. Yanli Jia

I Want to Remember: Preference for Visual Intensity in
Sentimental Purchases

» Dr. Chloe Huang, Dr. Fei (Katie) Xu, Prof. Yuwei Jiang

Rethinking the Elderly’s Motivation Shift in the Digital Era: The
Persuasive Impact of Time Perception and Goal Orientation

» Prof. Ji-Hern Kim, Prof. Dongwon Min, Ms. Seoyoun Chang

Breaking the Cycle of Moral Licensing: Leveraging Social Media for
Sustained Virtuous Acts

» Dr. Na Wen

The Moderating Effect of Life Role Transition on Customization in
Product Evaluation

» Ms. Yihui Cao, Prof. Liangyan Wang

Helping, Emotionally and Rationally: The Impact of Benefit
Framings on Donations

» Prof. Chia-Chi Chang, Ms. Chia-Hua Lin, Prof. Chun-Ming Yang

The Impact of Brand Acronyms on Popularity Perception: Does
Shortening a Brand Name Boost its Appeal?

» Ms. Yun ZENG, Prof. Hao SHEN

Show Us Your Name: The Effect of Power Distance Beliefs on
Evaluations of Wordmark Logos

» Dr. Min Jung Kim, Dr. Youngseon Kim, Dr. Joon Ho Lim

Page 32


https://www.exordo.com/?utm_source=acr2023&utm_medium=PDF&utm_campaign=PDF

Association For Consumer Research Conference 2023 26 - 29 Oct 2023 All times in PDT 4@

Continued from Friday, 27 October

Psychological distance of climate change and pro-environmental
behavior: The mediating roles of two types of risk perception

» Ms. Youngju Jung, Prof. Yongjun Sung

How Website Design Affects Consumers’ Switching Behaviors
» Ms. Huitian Zhang, Dr. Lei Su

Non-Random Effects: Designing & Analyzing Experiments With
Multiple Stimuli (In The Real World)

» Mr. Andres Montealegre, Prof. Uri Simonsohn, Prof. loannis
Evangelidis

Reputational Concerns in Charitable Giving
» Ms. Eva Fischer, Dr. Grant Donnelly, Dr. Michael Norton

Farmer's Personal Information Improves Consumer Responses to
Unattractive Produce

» Prof. Chun-Ming Yang, Ms. Xinyan Liu

Perceived Economic Inequality Increases Consumer’s Desire for
Cool Consumption

» Prof. Chun-Ming Yang, Ms. Chia-Hua Lin, Prof. Chia-Chi Chang

Mortality Salience Moderates Identity-Driven Preference for
Physical Over Digital Goods

» Dr. Rui "Aray" Chen, Dr. Ceyhan Kilic

Negative Effects of Greenwashing on Consumers’ Mental Health

» Ms. Youngju |ung, Prof. Yongjun Sung

It's not easy being green - Exploring consumer’s evaluation of
sustainable really new products

» Ms. Nadine Benninger, Prof. Steve Hoeffler
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When Less is More: Understanding Consumers’ Reaction to
Minimalist Appeals

» Dr. Jingshi Liu, Dr. Wei-fen Chen

The Psychometrics of Disgust in Consumer Reviews
» Ms. liani Xue, Prof. Maurice E. Schweitzer

Real or virtual? Promoting creativity and new product adoption
with virtuality

» Prof. Ying Ding, Ms. Ying Hu

Digital Repetition in Price Information

» Dr. |intao Zhang, Dr. Rajneesh Suri

Goal Conflict Enhances Consumer Preference for Minimalist
Aesthetics

» Dr. Siyun Chen, Dr. Tingwen Xiao, Prof. David Ahlstrom

A Gift is forever, or not! A Temporal Construal Perspective on
Preferences for Gifted Brands

» Dr. Marina Carnevale, Dr. Sara Williamson

One Good Turn Deserves Another: The Role of Karmic Beliefs and
Fundraising Types on Donations

» Prof. Chia-Chi Chang, Ms. Chia-Hua Lin, Prof. Chun-Ming Yang

The Impact of Ethical Company Ratings on Consumer Behavior
» Mr. Aaron Nichols, Dr. Romain Cadario, Prof. Nina Mazar

The Gritty Consumer: Maintaining Status Quo or Exploratory
Consumption?

» Mr. Logan Pant, Dr. Blair Kidwell

Three-dimensionality in Logo Design: How Logo Depth Improves
Consumers’ Brand Preference

» Prof. Taku Togawa, Prof. Naoto Onzo
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Brands, Don't Try Too Hard: When Aiming for Brand Relevance
Backfires as a Consequence of Effort in Identity-Signaling

» Dr. Matilde Rapezzi, Prof. Gabriele Pizzi, Prof. Gian Luca Marzocchi,
Prof. Daniele Scarpi

Understanding and Mitigating the Hobbies Paradox
» Ms. Mengchen Zheng, Prof. Anat Keinan, Prof. Nailya Ordabayeva

Transmission of Cultural Resources in the Provider-Customer Joint
Sphere of Professional Service

» Ms. Guilin Liu, Prof. Xi Liu

Towards Understanding Online Consumer Activism
» Dr. Philipp K. Wegerer

Enacting Van Life: A Practice Theory Perspective
» Dr. Philipp K. Wegerer

Experiential versus Material Products: Does the Rating Difference
Matter?

» Dr. Lina Xu, Dr. Yanfen You, Dr. Sumitra Auschaitrakul, Dr. Dan King

Shopping with a Price Comparison Browser Extension: Who Is the
Smart Shopper?

» Dr. Lina Xu

Be Real or Be Perfect? Dual Effects of Social Media Influencers’
Self-Disclosure on Brand Endorsement Attitudes

» Mr. Woocheol Kim, Dr. Conor M. Henderson, Dr. Julian K. Saint Clair

Perception of the social dimension of sustainability in the fashion
industry: A study across generational cohorts.

» Ms. Ericka Uribe Bravo, Dr. Citlali Calderon Fresse
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The Paradox of Ownership: How Non-Fungible Tokens (NFTs)
Affect Consumer Behavior

» Mr. Christian Parry, Dr. Alice Wang

Conversational Value: Virtual Conversational Agents As Not Only
A Conversation Partner But Also A Conversation Topic

» Dr. Wilson Bastos

Using a sustainability rationale for strict return policies to
alleviate the detrimental impact of online product returns

» Dr. Scott Connors, Dr. Bonnie Simpson, Ms. Michelle Li Chen

Highlighting the difference to make one: differential ethicality
framing increases the choice share of ethical options

» Mr. Zhuliang Liu, Dr. Aulona Ulginaku, Dr. Dionysius Ang, Dr.
Vasileios Davvetas, Prof. Barbara Summers

Enhancing consumer adoption of self-production offerings
through upskilling communication

» Dr. Aimal Hafeez, Prof. Marit Gunda Gundersen Engeset

Saturday, 28 october
7am Yoga
Everett
7:30am Registration
Spruce
8:15am 6.01 Special Session - Exploring Both Sides of the Aisle: How

Consumer and Marketer Political Ideology Shape Consumer
Behavior

Cedar
Chaired by: Ms. Saetbyeol Kim
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Pain-gain: Impact of Political Ideology and Producer’s Pain on
Product Evaluations

» Mr. Mayank Anand, Dr. Akshay Rao

Consumer Reactions to the Community Focus of a Smart Product:
The Moderating Role of Political Ideology

» Dr. Shuili Du, Dr. Min Zhao, Dr. Sankar Sen

The Effect of Physician Political Ideology on Consumer Medical
Decision Making

» Ms. Saetbyeol Kim, Dr. Caglar Irmak

Understanding How Consumers Respond to Conflicting Political
Information: Liberals Engage in Symmetric Updating and
Conservatives Engage in Asymmetric Updating

» Dr. Jeff Galak, Ms. Jianna Jin, Dr. Selin Malkoc

6.02 Special Session - New Insights from Large Language Models and

Natural Language Processing for Consumer Research
Issaquah
Chaired by: Dr. Ada Aka and Prof. John McCoy

Hindsight is Not 20/20: Recovering Consumer Perceptions in the
Past Using Longitudinal Text Analysis

» Mr. Vincent (Pei-Ming) Chen, Dr. Ming Hsu, Dr. Zhihao Zhang

The Language That Drives Engagement: A Systematic Large-scale
Analysis of Headline Experiments

» Dr. Akshina Banerjee, Dr. Oleg Urminsky

Machine-Assisted Social Psychology Hypothesis Generation

» Dr. Promothesh Chatterjee, Dr. Sachin Banker, Dr. Himanshu Mishra,
Dr. Arul Mishra

Studying Slogan Memorability with Large Language Models
» Dr. Ada Aka, Dr. John McCoy
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8:15am

6.03 Special Session - Mind the Body: The Next Decade of Research
about Bodily Influences in Decision Making

Jefferson
Chaired by: Dr. Aradhna Krishna

Impact of the Gut Microbiome Composition on Altruistic
Punishment Behavior

» Dr. Hilke Plassmann, Dr. Marie Falkenstein, Dr. Marie-Christine
Simon, Mr. Aakash Mantri, Dr. Bernd Weber, Dr. Leonie Koban

Beauty is in the Iris: Constricted Pupils (Enlarged Irises) Enhance
Attractiveness and Improve Attitudes

» Dr. Martina Cossu, Dr. Maria Giulia Trupia, Dr. Zachary Estes

Size-inclusive Model Photography in Online Fashion Retailing:
Improving Consumers’ Fit-risk Judgments Through Body-Size
Similarity

» Ms. Yerong Zhang, Dr. lina Ikonen, Dr. Jiska Eelen, Dr. Francesca
Sotgiu

6.04 Special Session - Unveiling Smart Sales Promotion Design
Willow A
Chaired by: Dr. Boyoun(Grace) Chae

The Token-Effort Effect: How Minimal Redemption Effort Increases
Price Promotion Effectiveness Over Straight Discounts

» Prof. Kuangjie Zhang, Prof. Thomas Allard, Prof. Nidhi Agrawal, Prof.
Rajesh Bagchi

Free vs. Pay a Little: Trivial-priced Coupon and Consumer
Conversion Behavior

» Ms. Zhengyu Shi, Dr. Jingcun Cao, Dr. Jinjie Chen, Prof. Echo Wan

“10% off Each”: How Implicitly Partitioned Percentage Framing
Affects Purchases Intention

» Dr. Shangwen Yi, Prof. David Hardisty, Prof. Katherine White
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The Impact of a Countdown Timer on the Effectiveness of Sales
Promotion

» Dr. Boyoun(Grace) Chae

6.05 Special Session - The Downstream Consequences of Sharing and
Receiving Temporal Information

Willow B
Chaired by: Ms. Jianna Jin

The Social Consequences of Time Tracking
» Ms. Jianna |in, Dr. Grant Donnelly

First Impression or Frequent Flyer? The Persuasive Effect of
Customer Tenure Claims in Online Word of Mouth

» Dr. Grant Donnelly, Prof. Jacqueline Rifkin

Time to Shine: How Temporal Orientation in Language Shapes Our
Influence

» Mr. David Fang, Prof. Sam Maglio

Perceptual Time Dilation: How Computational Ease Influences
Time Perception in Lab and Field Settings

» Mr. Deepak Sirwani, Prof. Suzanne Shu

6.06 Roundtable - Shaping Consumers’ Risk Perception and Risk
Preference to Bridge Attitude-Behavior Gaps

Ravenna
Chaired by: Dr. Claire Tsai and Dr. Leonard Lee

Shaping Consumers’ Risk Perception and Risk Preference to
Bridge Attitude-Behavior Gaps

» Dr. Claire Tsai, Dr. Leonard Lee, Prof. Christopher Hsee, Prof. Gita
ohar, Prof. Eric Johnson, Dr. John Lynch, Prof. Nina Mazar, Dr. Martin
ende, Dr. Geeta Menon, Dr. Nicole Robitaille, Dr. Maura Scott, Prof.
bigail Sussman, Dr. Zakary L. Tormala, Prof. Gulden Ulkimen, Ms.
Minwen Yang, Ms. Shoshana Segal, Mr. Weilun Yuen, Dr. Stacy Wood

M
Al
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6.07 Marketing Communications Reimagined: Unleashing
Persuasion through Freedom, Humor, and Nostalgia

Aspen
Chaired by: Dr. Hannah H. Chang

Consumer Cognitions of Voice-based Communications
» Dr. Hannah H. Chang, Dr. Anirban Mukherjee

CONSUMER RESPONSES TO FREEDOM APPEALS
» Prof. Martin Paul Fritze, Prof. Stefano Puntoni, Dr. Simona Botti

How Humor Affects Copycat Preference: The Role of
Acknowledging Imitation

» Mr. Seongun |eon, Dr. Femke van Horen, Dr. Michail Kokkoris

Predicting What Consumers Are Nostalgic For, And Why
» Dr. Matthew Farmer, Dr. Caleb Warren

6.08 Culture and Consumer Behavior: From Recycling Norms to
Global Identity

Columbia
Chaired by: Prof. Lisa Penaloza

Recycling: It's Not Just About the Environment, It's About Culture
» Dr. Mina Kwon, Dr. Minkyung Koo, Dr. Ashok Lalwani

Culture for Sale: Unpacking Consumer Perceptions of Cultural
Appropriation

» Mr. Jason Lin, Prof. Nicole Kim, Prof. Esther Uduehi, Prof. Anat Keinan

Local-Global Identity and Reliance on Online Reviews: The Role of
Need for Informative Information

» Dr. Xiaodong Nie, Dr. Sijie Sun

6.09 Empathy in Action: Examining the Dynamics of Giving and
Altruism

Seneca
Chaired by: Dr. Serena Hagerty
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Inequality in Opportunity Cost Salience
» Dr. Serena Hagerty

No More Than Once?: The Downside of Requesting Recurring
Donations in Attracting Donors

» Mr. Shih-Chun Chin, Prof. Cony Ming-Shen Ho, Prof. TzuShuo Ryan
Wang

The Effect of Flat Asks on Rounding-up change
» Mr. Bijit Ghosh, Dr. John Pracejus

Going the Extra Mile for Goodness: Unpacking the Moral Self-
Signaling Benefits of Effortful Cause Marketing Campaigns

» Dr. Argiro Kliamenakis, Dr. Onur Bodur

6.10 Nurturing Well-Being: Exploring Unique Paths to Health and
Happiness

Boren
Chaired by: Mr. Christoph Huller

Thinking of Pets Buffers against Psychological Pain via
Perceptions of Unconditional Love

» Dr. Martin Reimann, Mr. Christoph Huller, Dr. Evan MacLean

The Effect of Business Size on Consumer-Employee Conversation

» Mr. Michael Pecoy, Dr. Andrea Luangrath, Dr. Bowen Ruan, Mrs.
Sarah Luebke

“Wrinkles” Only Go Where Smiles Are: Exploring the Joint Effect of
Age and Message Framing on Consumers’ Disease Detection

» Ms. Yuting Pang, Prof. LiLi Wang, Prof. Fangyuan Chen

Life Stress Shapes Aesthetic Preferences: The Case of Minimalist
Design

» Ms. Shuhan Yang, Dr. Tito L.H. Grillo
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6.11 Navigating the Human-Tech Nexus: Trust, Labels, and
Technoism in Consumer Technology Interaction

Greenwood
Chaired by: Mr. Jonas Gorgen

Zero-Sum Beliefs and the Consumer Psychology of Technology
» Mr. Jonas Gorgen, Prof. Gergely Nyilasy, Prof. Emanuel de Bellis

Blockchain Encryption of Supply Chains and Animal Welfare Cues
and Their Impact on Consumers’ Assessment of High-Quality Meat

» Mrs. Kenya Kirsch, Prof. Andrea Groeppel-Klein

Single-Minded Al Agents and Cynical Consumer Inferences
» Prof. Adelle Yang, Ms. Yu Gu, Ms. Sijin Chen

Technoism: Relative preference for human predicts algorithm
aversion

» Mr. Moritz |oerling, Prof. Nico Heuvinck, Mrs. Gwarlann De Kerviler,
Mr. Derek D. Rucker

6.12 Navigating the Financial Maze: Insights into Minds, Money, and
Mobility

Redwood A&B

Chaired by: Mr. Philippe Wodnicki

‘I Will Never Not Be Poor’: Higher Economic Inequality Leads
Lower-Income Consumers to Give Up

» Mr. Philippe Wodnicki, Prof. Miranda Goode, Dr. Kirk Kristofferson

Financial Mindfulness: A Scale
» Dr. Emily Garbinsky, Dr. Simon Blanchard, Ms. Lena Kim

Responses to Financial Scarcity and Consumer Literacy
» Dr. Shaheen Hosany, Dr. Rebecca Hamilton

Understanding Borrower Motivations to Repay on a P2P Lending

Platform

» Mr. Akshay |yothiram lyer
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8:15am

9:30am

9:45am

9:45am

6.13 Tutorial - Hybrid Ethnographic Methods
Metropolitan B

Chaired by: Dr. Aimee Dinnin Huff and Dr. Andre F. Maciel and David
Crockett

» Dr. Andre F. Maciel (Presenter)

Coffee Break

9:45am
Grand Ballroom PFA
7.01 Special Session - Defining Products and Brands Through the
Lens of Stigmatized Identities
Cedar
Chaired by: Ms. Megan Trillo
How Stigmatized Brand Purpose Affects Consumer Product
Evaluations
» Ms. Megan Trillo, Dr. Lingrui Zhou, Dr. Keisha Cutright
Perceptions of Racial Diversity Enhance Ad Outcomes for
Stigmatized Products
» Mrs. Nicole Davis, Dr. Julio Sevilla
Brand User Imagery and Ethnic Cue (Mis)Matches
» Ms. Neha Nair, Dr. Sanjay Sood, Dr. Karl Aquino
How (Not) to Sell Inclusive Products to People of Color
» Dr. Ruoou Li, Dr. Linyun Yang, Dr. Andrea Morales
7.02 Special Session - Transformations in contemporary 9:45am

consumption cultures
Issaquah
Chaired by: Prof. Daiane Scaraboto
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Struggling to be a Vegan in an Omnivore World: Managing
Relational Tensions in Practice Performance Transformations

» Dr. Aya Aboelenien, Prof. Zeynep Arsel

Ludic Publics: Transformation through ludic consumption
» Ms. Nitisha Tomar, Dr. Amber Epp

Flipping the Script: Understanding Marketplace Dynamics through
Ritual Control

» Mr. Adam Slobodzian, Dr. Tandy Thomas

7.03 Special Session - Behavioral Science for the Climate Crisis:
Sustainability Judgment and Decision Making

Jefferson
Chaired by: Mr. Eli Sugerman

Making the Invisible Visible: Investigating Consumer Judgments of
Sustainability

» Mr. Eli Sugerman, Prof. EricJ. Johnson, Prof. Vicki Morwitz, Prof. Gita
Johar, Dr. Michael Morris

How bad is your carbon impact? Correcting miscalibration
promotes more sustainable food choices

» Dr. Gizem Ceylan, Prof. Ravi Dhar, Dr. Paul Stillman

Twice as nice? A Longitudinal Field Study of Separate vs.
Combined Nudges for Laundry Behaviors

» Prof. David Hardisty, Dr. Kirstin Appelt, Mr. Sid Mookerjee, Dr.
Yanwen Wang, Dr. Jiaying Zhao, Mr. Arien Kortelan

Calm to Green Choices: The Impact of Different Positive Arousal
States on Sustainability Decision-Making

» Ms. Anna Tari, Prof. Remi Trudel

7.04 Special Session - Consumer Numerical Decision-Making Biases
and Heuristics

Willow A
Chaired by: Dr. Evan Weingarten
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9:45am

9:45am

The Perceived Precision of Survey Research
» Dr. Nicholas Reinholtz, Prof. Bart De Langhe

Widely-Used Measures of Overconfidence Are Confounded With
Ability

» Dr. Stephen Spiller

9:45am

Memory Errors in Tracking Account Balances
» Mr. Nicholas Herzog, Dr. Dan Bartels

Anchoring: A Meta-Analysis and Metastudy

» Dr. Dan Schley, Dr. Evan Weingarten 9:45am

7.05 Special Session - The Decisions and Consequences of Time
Consumption

Willow B
Chaired by: Ms. Jacqueline Pan

On Time or On Thin Ice: How Perceived Quality is Affected when
Work is Submitted Early, On, or Past its Deadline

» Mr. David Fang, Prof. Sam Maglio

Using vs. Killing Time: How Verbs Shape Time Consumption
» Ms. Kun Wang, Dr. Gabriela Tonietto

The Unintended Consequences of ‘Productive’ Procrastination
» Ms. Jacqueline Pan, Prof. Jordan Etkin

How Consumers “Steal Time"” to Engage in Passive Leisure Alone
» Dr. Selin Malkoc, Prof. Ashley Whillans, Ms. Jianna Jin

7.06 Roundtable - Helping Consumers Become Happier: Research 9:45am

Gaps and Advice for Making an Impact
Ravenna
Chaired by: Prof. Michal Strahilevitz

Powered by Ex Ordo, everything you need to run a research conference.

Helping Consumers Become Happier: Research Gaps and Advice
for Making an Impact

» Prof. Michal Strahilevitz, Prof. Michael Norton, Prof. Lisa Cavanaugh,

Dr. Rajagopal Raghunathan, Dr. Aparna A. Labroo, Prof. Zoe Chance,

Mr. Joseph Harvey, Prof. Anirban Mukhopadhyay, Prof. Dominique
Braxton, Dr. Wendy Liu, Dr. Nicole Mead, Prof. Uzma Kahn

7.07 Beyond the Abstract: Bridging the Gap Between Academia and
Practice

Aspen
Chaired by: Pamela Dunaway and Dr. Maarten Bos

7.08 Subcultural Forces: From Fanfiction Fandoms to Gossiping
Markets

Columbia
Chaired by: Prof. Martin Paul Fritze

Beyond Scarcity: Non-Fungible Tokens and Digital Value
» Prof. Reto Hofstetter, Prof. Martin Paul Fritze, Dr. Cait Lamberton

Fanfiction: When Copyright Violation Benefits Brands
» Mr. Ethan Milne, Dr. Kirk Kristofferson, Prof. Miranda Goode

Gossip and Discordant Narrative Brand Evolution
» Dr. Kimberley Preiksaitis, Dr. Alexander Mitchell

Income Inequality Increases Consumption of Security Products:
The Role of Envy Anticipation

» Mr. Dallas Novakowski, Prof. Mehdi Mourali

7.09 From Boredom to Generosity: Examining the Complexities of
Prosocial Behavior

Seneca
Chaired by: Ms. Hongyu Meng
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Beautiful from the Outside in? Self-Perceived Attractiveness and
Prosocial Behavior

» Ms. Hongyu Meng, Prof. Jun Ye

Bored Out of Your (Human) Mind: Boredom Makes People Feel
Less Human and Less Prosocial

» Dr. Lauren Grewal, Dr. Roland Schroll, Prof. Dhruv Grewal, Prof. Stijn
van Osselaer

Automation Inhibits Prosocial Behavior: The Mediating Role of
Perceived Social Connectedness

» Dr. XIAOYAN (JENNY) LIU, Dr. Chi Hoang, Dr. Sharon Ng

The Honeymoon Fund Effect: Exerting Effort to Choose Increases
Generosity

» Dr. Siyuan Yin, Dr. Marissa Sharif

7.10 Emotional Undercurrents in Consumer Decision Making: Affect,
Envy, and Motivations

Boren

Chaired by: Dr. Ga-Eun (Grace) Oh 9:45am

The Effect of Being Envied on Indulgent Consumption

» Dr. Ga-Eun (Grace) Oh, Prof. Young Eun Huh

What Makes Consumers Watch Television Commercials?
» Dr. Velitchka Kaltcheva, Dr. Anthony Patino, Dr. Dennis Pitta

Reset Your Life: Fresh Start Mindset Increases Consumer Reliance
on Affect

» Prof. Chun-Ming Yang

The Moment of Truth: The Impact of Outcome Valence and
Revelation Timing on Shopping Process Enjoyment of Probabilistic
Goods

» Dr. Mingyue Zhang, Prof. Haipeng (Allan) Chen, Prof. Michael Tsiros

Powered by Ex Ordo, everything you need to run a research conference.

7.11 Interacting with Tech: Exploring Consumer Choices in the Age of
Automation

Greenwood
Chaired by: Prof. Julian De Freitas

Public Perception and Autonomous Vehicle Liability

» Prof. Julian De Freitas, Ms. Xilin Zhou, Ms. Shoshana Boardman, Ms.
Margerita Atzei, Dr. Luigi Di Lillo

A Meta-Analytic Investigation into the Relative Effectiveness of
Human versus Al Recommendations

» Ms. Manhui [in, Dr. Zhiyong Yang, Dr. Traci Freling, Dr. Narayanan
Janakiraman

Smartphones for Enjoying the Process and PCs for Achieving the
Outcome: The Influence of Activity Focus on Electronic Device
Selection

» Ms. Shugi Zhu, Dr. Sarah Wei, Prof. John Rudd, Dr. Yansong Hu

Allow or Deny: The Impact of Information Access Mode on
Willingness to Share Personal Information

» Dr. Ana Scekic, Dr. Tatiana Sokolova, Dr. Aradhna Krishna

7.12 Empowering Your Wallet: Insights into Financial Behavior and
Decision Making

Redwood A&B
Chaired by: Dr. Christopher Cannon

How Gender Stereotypes Shape Relative Income Preferences in a
Partner

» Dr. Christopher Cannon, Dr. Emily Garbinsky

Helping Lower-Income People Start Claiming a Tax Credit

» Dr. Wendy De La Rosa, Dr. Ron Berman, Dr. Christophe Van den
Bulte

Conceptualizing and Measuring Financial Consumer Resilience

» Dr. Janina Magdalena Schaumann, Prof. Sabrina Hegner, Prof. Armin

Varmaz, Mrs. Katharina Riebe
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9:45am

11:15am

11:15am

I or Them: How Self-Motives Impact Financial Behavior
» Dr. Patricia Torres

7.13 Tutorial - Gathering Internet Data
Metropolitan B
Chaired by: Dr. Shane Wang and Dr. Johannes Boegershausen

8.01 Special Session - Biting the Bullet: The Intersection of Gun
Violence and Marketing

Cedar
Chaired by: Dr. Nicholas Light

Perceptions and Misperceptions of Support for Firms' Actions to
Reduce Gun Violence

» Dr. Nicholas Light, Dr. Justin Pomerance, Dr. Lawrence Williams

Second Order Effects of Marketing Interventions: Evidence from
Firearm Daily Deals

» Dr. Ted Matherly, Dr. Brad Greenwood

Catalyzing Social Change: Does Concentration Encourage Action?
» Prof. Jonah Berger, Dr. Joshua Jackson, Dr. Ceren Kolsarici

The Problematic Legitimation of the Armed American Woman
» Dr. Aimee Dinnin Huff, Dr. Brett Burkhardt, Dr. Michelle Barnhart

8.02 Special Session - From Genes to Markets: Leveraging Biological
Methods to Study Consumer Behavior

Issaquah
Chaired by: Dr. Steve Shaw

Powered by Ex Ordo, everything you need to run a research conference.

11:15am

Quantifying brain signatures of self-relevance

» Dr. Bruce Dore, Dr. Nicole Cooper, Dr. Matthew Brook O'Donnell, Dr.
Hang Yee Chan, Dr. Christin Scholz, Dr. Emily Falk

A random utility account of neuroforecasting: How neural
measures improve forecasts of market-level behavior

» Dr. Alexander Genevsky, Mr. Lester Tong, Dr. Brian Knutson

Brand empathy: How consumers resonate socially and
emotionally with brands

» Dr. JIN HO YUN, Dr. Feng Sheng, Dr. Michael Platt

Biological age and its value to consumer research
» Dr. Steve Shaw, Dr. Remi Daviet, Dr. Gideon Nave

8.03 Special Session - Ironic Consumer Behavior: Misconceptions,
Mistakes, and Miscommunications in the Marketplace

Jefferson
Chaired by: Ms. Julia Jeong

Consumers Believe Legal Products Are Less Effective Than lllegal
Products

» Dr. Alicea Lieberman, Dr. Rachel Gershon, Dr. Sydney Scott

“You Had to Work Harder than Me": Self-Other Discrepancy in the
Attribution and Communication of Skill

» Ms. Julia |eong, Prof. Rima Touré-Tillery, Dr. Neal Roese

Anticipating Giving Feedback Changes Consumers’ Feedback
» Dr. Melanie Brucks, Dr. Kristen Duke, Ms. Daniella Turetski

The Self-Sabotaging Effect: Internal Credit Need Reduces
Preferences for Highly Instrumental Means

» Dr. Jessica Gamlin, Dr. Aparna A. Labroo, Dr. Noelle Nelson
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11:15am

11:15am

8.04 Special Session - Thriving on Authenticity: Understanding How
Consumers Infer Authenticity in People and Brands

Willow A
Chaired by: Dr. Tianyi Li

The Spot of a Leopard: Improving One’s Warmth Leads to
Perceived Inauthenticity

» Dr. Tianyi Li, Dr. David Gal

From Ideal to Real: How Idealized Versus Non-ldealized Models
Influence Perceived Brand Authenticity and Brand Outcomes

» Dr. Rosanna K. Smith, Ms. Yiyue Zhang, Ms. Beeson Shin

A Motivated Theory of Mind: Beliefs in the True Self Guide
Theories About Others’ Preferences

» Mr. Daniel |. Chiacchia, Dr. George E. Newman, Dr. Rachel L. Ruttan

Imperfection as a Costly Signal of Authenticity: An Integrative
Theoretical Framework

» Dr. Amit Bhattacharijee, Dr. Alixandra Barasch, Dr. Klaus Wertenbroch

8.05 Special Session - Measurement and Sampling Issues in
Consumer Research

Willow B
Chaired by: Mr. Randy Gao

Exposing Omitted Moderators: Explaining Differences in
Treatment Effects in the Social Sciences

» Prof. Antonia Krefeld-Schwalb, Mr. Eli Sugerman, Prof. Eric Johnson

A Framework for Screening and Assessing Sample Quality
Obtained From Online Services

» Prof. Aaron Arndt, Prof. John Ford, Prof. Barry Babin, Mr. Vinh Luong

Powered by Ex Ordo, everything you need to run a research conference.

11:15am

11:15am

Extremity Bias in Survey Responses Generates Strong Yet Invalid
Results

» Mr. Randy Gao, Ms. Liman Wang, Prof. Leif Nelson

Non-Random Effects: Designing & Analyzing Experiments With
Multiple Stimuli (In The Real World)

» Mr. Andres Montealegre, Prof. Uri Simonsohn, Prof. loannis
Evangelidis

8.06 Roundtable - Navigating the Contradictions: Understanding the
Complexities of Social Media's Effects on Consumers' Well-being

Ravenna
Chaired by: Dr. Elena Fumagalli and Dr. L. J. Shrum

Navigating the Contradictions: Understanding the Complexities of
Social Media's Effects on Consumers' Well-being

» Dr. Elena Fumagalli, Dr. L. ]. Shrum, Dr. Tina Lowrey, Dr. Connie

Pechmann, Dr. Lan Chaplin, Dr. Mario Pandelaere, Dr. Kathleen Vohs,
Dr. Russell Belk, Prof. Lena Cavusoglu, Dr. Rhonda Hadi, Dr. Deborah

ohn, Prof. Margaret Echelbarger

8.07 Insights into Flawed Human Decision Making: Biases, Social
Influence, and Beyond

Aspen
Chaired by: Dr. Maximilian Gaerth

The Null Event Bias in Perceptions of Causality
» Dr. Maximilian Gaerth, Dr. Cait Lamberton, Dr. Selin Malkoc

Similarity Penalty: How Idea Assortment Influences Evaluation in
Crowdsourcing

» Prof. Reto Hofstetter, Prof. Harikesh Nair, Prof. Sanjog Misra, Mr.
Felix Schakols

Do People Follow the Majority of Observed Behaviors or the
Behavior of the Majority?

» Dr. Thomas Karl Alfred Woiczyk, Dr. Rahil Hosseini, Prof. Gaél Le
Mens
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11:15am

11:15am

The CRT is not “just” Math: an adversarial collaboration

» Prof. Andrew Meyer, Dr. Yigal Attali, Prof. Maya Bar-Hillel, Prof. Shane
Frederick, Prof. Daniel Kahneman

8.08 Memory in Marketing: Unraveling Brain Responses, Processing
Fluency, and Virtual Influencer Effectiveness

Columbia
Chaired by: Prof. Moran Cerf

How many times do you need to view content before it is
registered in your memory

» Prof. Moran Cerf

To be or Not to Be Sarcastic! Gender-Stereotypes about Brand's
Humour.

» Mr. Murtuza Soofi Mohammed, Prof. Gabriele Pizzi

Robustness of Fluency Effects in Marketing Research - A Meta-
Analysis

» Mr. Lennart Kehl, Prof. Jan R. Landwehr

Mouse-Tracking Substantiates the Contributions of
Predispositions and Evaluations in Consumer Choice

» Dr. Nitisha Desai, Dr. Paul Stillman, Dr. Kentaro Fujita, Dr. lan
Krajbich

8.09 Changing Hearts and Shaping Giving: Exploring the Dynamics of
Prosocial Power

Seneca
Chaired by: Dr. Jessie Rui Du

The Language of Prosocial Behavior: English as a Lingua Franca

» Dr. |essie Rui Du, Dr. Steve Gould, Dr. Sankar Sen, Dr. Marlone
Henderson

Powered by Ex Ordo, everything you need to run a research conference.

11:15am

11:15am

Retributive Philanthropy
» Mr. Ethan Milne, Dr. Kirk Kristofferson, Prof. Miranda Goode

Simple Math Will Help: The Effect of Numerical Divisibility in
Fundraising

» Ms. Hui Li, Dr. Yunlu Yin, Dr. Qian Xu

The Charity Competence Curse: When Signals of Managerial
Competence Backfire

» Dr. Lijun (Shirley) Zhang, Prof. Thomas Allard, Prof. David Hardisty,
Dr. Shane Wang

8.10 The Crowded Room: Self, Identity, and Consumption
Boren
Chaired by: Ms. Chia-Han Chang

I Just Want Something New! Social Exclusion Enhances Consumers’
Novelty-Seeking

» Prof. Chun-Tuan Chang, Prof. Zhao-Hong Cheng, Ms. Chia-Han
Chang, Prof. Yu-Kang Lee

The Role of Racial Identity and White Guilt in Consumer
Evaluations

» Dr. Ekin Ok, Dr. Rishad Habib, Dr. Karl Aquino, Mr. Sid Mookerjee, Dr.
Yann Cornil

No One Needs to Know: The Emotional Costs of Outsourcing Tasks
» Ms. Pooja Somasundaram, Prof. Jenny Olson, Prof. Elanor Williams

Beyond the Plate: The Role of Distinction and Connection Cues in
Shaping Perceived Authenticity of Dining Experiences

» Dr. Xianfang Zeng

8.11 Redefining Luxury: From Green Consumption to Memes and
Aesthetics

Greenwood
Chaired by: Dr. Silvia Bellezza
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Eco-Elites: Reevaluating Green Consumption Among High-Status
Consumers

» Dr. Silvia Bellezza, Dr. Joe Gladstone

What Does Luxury Meme? New Cultural Intermediaries and the
Reconfiguration of Marketplace Meanings

» Prof. Julia Pueschel, Prof. Stéphane Borraz

Sustaining Excellence: Embedded (not Peripheral) Sustainability
Aligns with Luxury

» Prof. Ludovica Cesareo, Prof. Vanessa Patrick-Ralhan

Constructing Aesthetic Preferences: The Interplay of Individual
and Social Influences

» Ms. Jenny Yoo, Dr. Piotr Winkielman

8.12 Power Play: Unraveling Political Minds in a Polarized World
Redwood A&B
Chaired by: Dr. Rhia Catapano

Why Boycotts Fail: Political Beliefs (Mis)shape Memory of
Behavior

» Dr. Rhia Catapano, Dr. Katherine DeCelles, Dr. Brayden King, Dr.
Michael Norton

Is Uncertainty Avoidance a Defining Characteristic of
Conservatism or Extremism?

» Dr. Donald Gaffney, Dr. Joshua Clarkson, Prof. Frank Kardes

The Voter’s lllusion and Consumer Choice
» Dr. Fausto Gonzalez, Dr. Hannah Perfecto

Work “for” you or Work “with” you: The effect of a political
candidate's positioning on donations

» Dr. Cony Ho, Dr. Daniel Grossman

Powered by Ex Ordo, everything you need to run a research conference.

12:30pm

2:30pm

2:30pm

8.13 Tutorial - Al Doesn’t have to be racist and sexist
Metropolitan B
Chaired by: Dr. Broderick Turner and Xiao Liu and Ayelet Israeli

LUNCH- ACR Awards and Business Meeting
Grand Ballroom (ABCD)

9.01 Special Session - What Shapes the Impact of Online Content?
Cedar
Chaired by: Dr. Ali Faraji-Rad

From Words to Emotional Expertise: Measuring and
Understanding Emotional Granularity in Online Word-of-Mouth

» Dr. Ali Faraji-Rad, Dr. Ali Tamaddoni, Mrs. Atefeh Jebeli

The Topography of Word-of-Mouth
» Dr. |effrey Lee, Prof. Jonah Berger

A Linguistic Signature of Sharing
» Dr. Bruce Dore, Prof. Jonah Berger

Can You Sell Millions of Lipsticks in 5 Minutes? A Multi-method
Comprehensive Analysis of Winning Content Strategies of Top
Livestreaming Influencers

» Dr. Fang Wan, Ms. Ruigi Guan, Dr. Mansur Khamitov, Dr. Mei Huang

9.02 Special Session - Navigating Uncertainty: Uncovering the
Influence of Uncertainty on Consumer Trust

Issaquah
Chaired by: Prof. Gulden Ulkiimen

Improving Claim Credibility under Epistemic and Aleatory
Uncertainty

» Dr. Felipe M. Affonso, Mr. Amin Shiri

Page 44


https://www.exordo.com/?utm_source=acr2023&utm_medium=PDF&utm_campaign=PDF

Association for Consumer Research Conference 2023 26 - 29 Oct 2023 All times in PDT g,\, &

Continued from Saturday, 28 October

Metacognitive Monitoring Compensates for Memory Limitations
in Open-Ended Decisions

Low Probability, No Credibility
» Ms. M. Leonor Neto, Dr. Lucius Caviola

» Dr. Zhihao Zhang, Dr. Andrew Kayser, Dr. Ming Hsu

2:30pm 9.05 Special Session - Field Experiments: A Practical Tutorial

Price Contrasts in the Wild Willow B

» Dr. Ariel Fridman, Prof. On Amir Chaired by: Prof. Praveen Kopalle and Prof. Rajesh Chandy and Prof.
Stephen Anderson

2:30pm 9.03 Special Session - The Many Facets of Sustainability: Novel

Insights into Sustainable Consumption

Jefferson

Chaired by: Prof. Amna Kirmani 2:30pm 9.06 Roundtable - Projective Techniques in Consumer Research
Ravenna

The Value of Having Been Used Before: Heightened Consumer Chaired by: Prof. Cristel Russell

Value Perceptions of Products Made from Recycled Materials

» Dr. Edward Yuhang Lai, Prof. Rajesh Bagchi L . .
Projective Techniques in Consumer Research

Why Do Consumers Resist Lab-Grown Meat? A Life-Creation » Prof. Cristel Russell, Prof. Linda Tuncay Zayer, Prof. Jenna Drenten

Perception Theory

» Dr. Qihui Chen, Prof. Yajin Wang 2:30pm 9.07 Mind Games: Unraveling Consumer Biases and Decision
Heuristics

Choosing to Make a Difference: §alience of Choice Increases Aspen

Consumers’ Support for the Environment Chaired by: Mr. Soaham Bharti

» Prof. Shilpa Madan, Dr. Kevin Nanakdewa, Ms. Jinyan Xiang, Prof.

Krishna Savani
Consumers opt for more attribute upgrades when selecting

2:30pm 9.04 Special Session - Process and Content in Memory-Based among preconfigured products as opposed to configuring the

Choices: Cognitive and Computational Perspectives
Willow A
Chaired by: Dr. Stephen Spiller

Decisions from Memory: Uncovering the Temporal Dynamics of
Open-Ended Decisions

» Ms. Xiaozhi Yang, Dr. Zhihao Zhang, Dr. Ming Hsu, Dr. lan Krajbich

Inferring Consideration Sets: A Computational Model of
Naturalistic Memory-Based Decision Making

» Dr. Ada Aka, Mr. Lionel Schatz, Dr. Sudeep Bhatia

Powered by Ex Ordo, everything you need to run a research conference.

product themselves
» Mr. Soaham Bharti, Prof. Berkeley Dietvorst

Asymmetric causal impact of increasing versus decreasing
product dose on perceived efficacy

» Mr. Soaham Bharti, Dr. Dan Bartels

The Mere Audience-Size Effect: When and Why a Large Audience
Non-Normatively Inflates the Perceived Competence of Actors

» Mr. Tian Qiu, Dr. Xilin Li, Prof. Jingyi Lu
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2:30pm

2:30pm

Consumption Portfolio Management: Very Good Stuff Is Best
Enjoyed by Itself

» Dr. Luxi Shen, Ms. Chong Yu, Dr. Andrew Meyer

9.08 Flipping Perceptions: From Insults to Insights, Ownership to
Expertise

Columbia
Chaired by: Dr. Michelle Daniels

Right Back at You: When and Why Deflecting Compliments
Represents a Smart Social Strategy

» Dr. Michelle Daniels, Ms. Xin Zhou, Dr. Adriana Samper

Bunch of Jerks: When Brands Reappropriate Insults
» Dr. Katherine Du, Dr. Lingrui Zhou, Dr. Keisha Cutright

Repeated Exposures to Images Increase Perceived Truth Ratings
» Ms. Farhana Tabassum, Dr. Klemens Knoeferle, Dr. Luk Warlop

What's Mine Makes Me an Expert: Psychological Ownership
Increases Advice Giving by Inflating Subjective Expertise

» Ms. Seo Young Myaeng, Dr. Jake Teeny

9.09 Chasing Dreams and Shaping Desires: Exploring the
Complexities of Goals and Motivation in Consumer Behavior

Seneca
Chaired by: Dr. Elizabeth Friedman

The (Better) Road Not Taken: Setting Explicit Goals Reduces
Switching to More Effective Alternatives

» Dr. Elizabeth Friedman, Dr. Guy Voichek, Prof. Ravi Dhar

The Consumption Order Effect in Knowledge Acquisition
» Ms. Xinping WEI, Prof. Leilei Gao

Powered by Ex Ordo, everything you need to run a research conference.

2:30pm

2:30pm

Failing to give the gift of improvement: When and why givers
under-give self-improvement gifts

» Dr. Farnoush Reshadi

Conceptualizing Wellness: Mindful Consumption to Feel
Holistically Healthier

» Mr. Daniel Russman, Dr. Kristen Duke

9.10 Emotions in Flux: Exploring Affect and Identity in the Digital
Age

Boren

Chaired by: Prof. Elaine Chan

How Online Attention Influences Consumers’ Spotlight Biases
» Dr. Matthew Hall

The Backfiring Effect of NFTs: Unique NFTs Trigger Entitlement
and Selfishness in Crypto-Communities

» Mr. Anush Sridhar, Mr. Jonas Gorgen, Prof. Emanuel de Bellis, Prof.
Reto Hofstetter

Home is Where Your Stuff is: A Longitudinal Study into the Effects
of Working from Home on Feelings of Home

» Dr. Rusty Stough, Dr. Meredith Rhoads Thomas

The Effect of Loneliness on Consumer Preference for Complex
Design Products

» Ms. Ting Li, Prof. Fenghua Wang

9.11 Unlocking the Power of Words: Linguistics and Semantics in
Consumer Insights

Greenwood
Chaired by: Dr. Joshua Dorsey

From Stoned to Sustenance: A Conceptual Introduction to
Cannabis for Well-being

» Dr. Joshua Dorsey, Dr. Ronald Paul Hill, Mr. Kevin Fox
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3:45pm

Semantic Network Analysis in Consumer Research

. . . 4pm
» Dr. Philipp Jaufenthaler, Dr. Jonathan David Schéps

That's it! how two words can influence perceived price complexity 4pm
and the resulting purchase behavior

» Mr. Gal Mazor, Dr. Dikla Perez, Prof. Ann Kronrod

When and Why Comparative Reviews Are (Un)helpful
» Dr. Charles Zhang, Ms. Shoucong (Carol) Xiong

9.12 Roundtable - Everyone everywhere all at once: integrating
novel approaches to social influence(rs)

Redwood A&B
Chaired by: Dr. Meyrav Shoham and Dr. Jared Watson

Everyone everywhere all at once: integrating novel approaches to
social influence(rs)

» Dr. Meyrav Shoham, Dr. Jared Watson, Dr. Hayley Cocker, Dr.
Michelle Daniels, Dr. Lauren Grewal, Dr. Mansur Khamitov, Dr. Rebecca
Mardon, Dr. Ted Matherly, Dr. Coby Morvinski, Dr. Edith Shalev, Dr.
Rosanna K. Smith, Dr. Francesca Valsesia, Dr. Freeman Wu

9.13 Plenary - Health and Financial Decision Making through the 4pm
Lens of Consumer Well Being and Public Policy

Metropolitan B

Journal of the Association for Consumer Research (JACR)
Information Session

Capitol Hill
Chaired by: Prof. Vicki Morwitz

Powered by Ex Ordo, everything you need to run a research conference.

Coffee Break
Grand Ballroom PFA

Yoga
Everett

10.01 Special Session - Explaining Al: Consumers' lllusionary Sense of
Understanding How Algorithms Work

Cedar
Chaired by: Dr. Diogo Hildebrand

Prospects of Explanations Foster Illusory Understanding of Al
» Dr. Massimiliano Ostinelli, Dr. Andrea Bonezzi, Dr. Monika Lisjak

“We" Listen to Algorithms: How Cultural Values Influence the
Acceptance of Al Recommendations

» Ms. Yuanyuan Zhang, Dr. Diogo Hildebrand, Dr. Ana Valenzuela

Al as the Generalist

» Ms. Jiajia Liu, Dr. Phyliss Gai

Theory of Machine: Consumer Lay Beliefs About Algorithmic Data
Processing Drive Recommendation Acceptance

» Mr. Alcheikh Edmond Kozah, Dr. Ana Valenzuela

10.02 Special Session - Backfiring of Favorable Strategies for
Increasing Consumption and Motivation

Issaquah
Chaired by: Ms. Angela Xiao

When and Why Redeeming Loyalty Points Leads to Disloyal
Customers

» Ms. Lena Kim, Dr. Kaitlin Woolley, Dr. Marissa Sharif
A Little Bit of Each: Breaking Down a Goal into Detailed

Subcategories Leads to More Ambitious Planning
» Ms. Angela Xiao, Dr. Joy Lu
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4pm

4pm

The Placeholder Effect: Using Break Days to Help Form Habits
» Dr. Siyuan Yin, Dr. Marissa Sharif

Asking Consumers to Spend Time to Save Money Is Fairer Than
Asking Them to Spend Money to Save Time

» Dr. Maria Giulia Trupia, Dr. Franklin Shaddy

10.03 Special Session - Spreading Good Well by Giving More - Insights
for Increasing Charitable Donations

Jefferson
Chaired by: Ms. Michael Caitlin

It's (Not) My Money! Leveraging Psychological Ownership to
Increase Charitable Giving

» Ms. Caitlin Michael, Dr. Stephen X. He, Dr. Julian Givi

Cultural Tightness-Looseness and Charitable Giving
» Dr. Fatima Madani, Dr. Ali Gohary, Dr. Eugene Chan

The Dark Side of Opportunity: High Perceived Economic Mobility
Reduces Dependency-Oriented Charitable Behavior

» Dr. Yujie (Jay) Zhao, Mr. Pete Zhou, Dr. Lin He

I'll Donate Nail Clippers but Not Lipstick: Why Donors Avoid
Charities That Provide Recipients with Hedonic Products

» Dr. Aviva Philipp-Muller, Dr. John P. Costello

10.04 Special Session - The Multifaceted Impact of Numerical
Framing: Exploring Consumer Behavior in Ratings, Advertising, and
Communication Contexts

Willow A
Chaired by: Mr. Deepak Sirwani

Fooled by Stars: Perceptual Biases in Judgments of Numeric
Ratings
» Mr. Deepak Sirwani, Ms. Srishti Kumar, Prof. Manoj Thomas

Powered by Ex Ordo, everything you need to run a research conference.

4pm

4pm

Overstated or Understated?: An Anchoring and Adjustment Model
for How Conflicting Lay Theories Guide Judgments of Product
Lifespan Claims

» Prof. Mathew Isaac, Prof. Elisa Konya-Baumbach, Prof. Rebecca
Reczek

ROAS vs. ACOS: Malleability of Advertising Success Metrics

» Mr. Archer Pan, Mr. Jean-Louis Sterckx, Prof. Bart De Langhe, Prof.
Stijn van Osselaer

Relative Increases Appear Larger in Percentage Terms
» Prof. Joowon Klusowski, Prof. Joshua Lewis

10.05 Special Session - The Policing Market
Willow B
Chaired by: Dr. Kate Christensen

Branding the State: Using Brand Management to Increase
Confidence in Institutions

» Dr. Breagin Riley

School Shootings and Consumption Behavior of Affected
Communities

» Dr. Muzeeb Shaik, Dr. Mike Palazzolo, Dr. Adithya Pattabhiramaiah,
Dr. Shrihari Sridhar

Smartphone Data Reveal Neighborhood-Level Racial Disparities in
Police Presence

» Dr. Kate Christensen, Dr. M. Keith Chen, Dr. Elicia John, Dr. Emily
Owens, Ms. Yilin Zhuo

The Effect of Police Training on Officer Mindset
» Dr. Broderick Turner, Dr. Kate Christensen, Dr. Kyle Dobson

10.06 Roundtable - Accessibility and Disability in Consumer
Research

Ravenna
Chaired by: Dr. Johannes Boegershausen
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Accessibility and Disability in Consumer Research

» Dr. Johannes Boegershausen, Dr. Lauren Grewal, Dr. Helen Van der
Sluis, Dr. Stacey Menzel Baker, Dr. Melanie Brucks, Dr. Martina Cossu,
Dr. Samantha Cross, Dr. Katharina C. Husemann, Dr. Uzma Khan, Dr.
Aparna A. Labroo, Ms. Maayan Malter, Prof. Vanessa Patrick, Dr.
Adriana Samper

10.07 Love is Blind (And Biased): Examining Consumers' Reliance on
Heuristics and Biases

Aspen
Chaired by: Prof. Ariel Fridman

Dominance Effects in the Wild
» Prof. Ariel Fridman, Prof. On Amir, Prof. Karsten Hansen

Making Sense of Dominated Options: Implications of Dominated
Options for Trust and Choice

» Dr. Joseph Reiff, Dr. Jon Bogard, Dr. Eugene Caruso, Dr. Hal
Hershfield

Not Willing to Compromise: Adding A Common Negative Feature
Decreases Consumer Choice of the More Desirable Product

» Ms. May Yuan, Prof. Leilei Gao

10.08 The Emotional Consumer: Reach, Influencers, and Nostalgia
Columbia
Chaired by: Dr. Jia Chen

Identifying Nostalgia in Text: The Development and Validation of
the Nostalgia Dictionary

» Dr. Jia Chen, Dr. Kristin Layous, Dr. Tim Wildschut, Dr. Constantine
Sedikides

Powered by Ex Ordo, everything you need to run a research conference.

4pm

4pm

The More the Merrier? Influencer Reach and Consumer
Engagement

» Dr. Charlene Chu, Dr. Cristina Nistor, Dr. Ekin Pehlivan, Dr. Taylan
Yalcin

How the Elicitation Procedure Shapes Beliefs about Others’
Affective Responses to Action and Inaction

» Prof. loannis Evangelidis, Prof. Manissa Putri Gunadi

The role of Al-mediated relationships in emotional experience and
well-being

» Dr. Clara Koetz, Dr. Ozlem Ozkok, Dr. Sarah Hudson

10.09 Navigating Cognitive Distortions: Exploring the Impact of
Pricing, Ratings, Risk Perception, and Score Differences

Seneca
Chaired by: Dr. Shreyans Goenka

Price Partitioning of Socio-Moral Surcharges
» Dr. Shreyans Goenka, Prof. Rajesh Bagchi

When Risk is More (vs. Less) Probable: The Impact of Denominator
Magnitude on Probability Judgment

» Dr. Hoori Rafieian, Dr. Anubhav Aggarwal

The Power of a Star Rating: The Differential Effects of Analog and
Numerical Rating Formats on Magnitude Perceptions and
Consumer Reactions

» Dr. Annika Abell, Dr. Carter Morgan, Dr. Marisabel Romero

10.10 Information Odyssey: Examining the Consumer's Journey from
Binge-Watching to Fake News

Boren
Chaired by: Ms. Rachele Ciulli

When “Netflix and Chill” Leaves us Cold: Binge-Watching,
Opportunity Costs, and Satisfaction

» Ms. Rachele Ciulli, Dr. Cait Lamberton
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Complexity of Recognition in Sponsorship Ecosystems: An
Expanded Role of Proactive Interference

» Dr. Steffen Jahn, Prof. T. Bettina Cornwell, Prof. Michael S.
Humphreys

Let Me Know How Much | Can Save with This Coupon: How
Coupon Framing Influences Coupon Redemption Behavior

» Ms. SINING KOU, Dr. Shen (Daniel) Duan, Dr. Lei Su, Prof. Haipeng
(Allan) Chen

Does Good or Bad Fake News Matter? The Impact of Brand
Misinformation Valence and Correction Source on Consumer
Behavior

» Mrs. Xiajing Zhu, Ms. Xinran Wang, Dr. Lefa Teng

10.11 The Emotional Compass: Exploring the Intersection of
Emotions, Decisions, and Consumption

Greenwood
Chaired by: Dr. Ethan Pancer

The impact of automation in restaurants

» Dr. Ethan Pancer, Dr. Theo Noseworthy, Dr. Lindsay McShane, Dr.
Nukhet Taylor, Dr. Matthew Philp

The Effect of Scarcity and Social Exclusion on Consumer Response
to Product Failure

» Dr. Jane So, Prof. Nidhi Agrawal

The Dark Side of Ambient Lighting: How Darkness Induces Risk-
Taking Through Emotions

» Dr. Kylie Vo, Dr. Blair Kidwell, Dr. Yuna Choe

Prediction Aversion: The Unbearable Heft of Knowing the Future
» Dr. Yuechen Wu, Dr. Meng Zhu, Dr. Erik Helzer

Powered by Ex Ordo, everything you need to run a research conference.

4pm

10.12 Unmasking Dishonesty: Tools and Techniques for Enhancing
Trust in Consumer Research Findings

Redwood A&B
Chaired by: Ms. Susanne Adler

A toolbox to identify p-hacking: Four techniques to evaluate the
trustworthiness of published findings

» Ms. Susanne Adler, Dr. Lukas Roseler, Ms. Martina Katharina
Schoniger

Dampening the noise: Ways to account for measurement error in
experimental consumer research

» Prof. Thomas Niemand, Dr. Robert Mai

Systematic Errors in Interpreting Binary Dependent Variables:
Demonstrations and Recommendations

» Dr. Shwetha Mariadassou, Dr. Christopher Bechler, Dr. Blakeley
McShane, Dr. S. Christian Wheeler

A Systematic Investigation of Attention Checks in Consumer
Behavior Research

» Dr. Hannah Perfecto, Dr. Michael O'Donnell

10.13 Breaking Boundaries in Marketing: Innovative Approaches to
DEI, Healthcare Access, and Poverty Alleviation

Metropolitan B
Chaired by: Dr. Siti Agilah Jahari

Vulva Centric Femvertising: A Case from Malaysia
» Mr. Shafiullah Anis, Dr. Juliana A. French, Dr. Siti Agilah Jahari

Harnessing the power of Marketing at all levels: A synthesis of the
Bottom of Pyramid and Subsistence Marketplaces approach to
solve the wicked problems of Society.

» Mr. Abheeshek Dev Roye, Prof. Geetha Mohan

Reconsidering Consumer Access to Healthcare

» Prof. Lynn Sudbury-Riley, Prof. Philippa Hunter-Jones, Dr. Ahmed Al-
Abdin
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Using Al to Implement DEI into Marketing Materials

» Dr. Patrick van Esch, Dr. Yuanyuan (Gina) Cui, Dr. Gavin Northey, Dr.
Vicki Andonopoulos

11.01 Special Session - Consumer Ratings of Products and
Experiences

Cedar
Chaired by: Mr. Mohin Banker

Consumer Generalizations of Positive and Negative Information
» Mr. Mohin Banker, Prof. Joowon Klusowski, Dr. Gal Zauberman

How Does Rating Specific Features of An Experience Alter
Consumers’ Overall Evaluation of That Experience?

» Prof. Katie Mehr, Prof. Joseph Simmons

Judging by the Numbers: Exploring How Raw-Scores Affect
Consumer Judgment in the Face of Superseding Percentiles

» Dr. Julian Givi, Dr. Daniel Grossman, Prof. Frank Kardes

How Consumers Evaluate Product Ratings Distributions: The Role
of Summary Representations

» Dr. Daniel Villanova, Dr. Elise Chandon Ince, Prof. Rajesh Bagchi

11.02 Special Session - The Effectiveness of Influencer Marketing
Issaquah
Chaired by: Ms. Xueqi Bao

How Sensory Language Shapes Responses to Influencer Content

» Mr. Giovanni Luca Cascio Rizzo, Prof. Jonah Berger, Prof. Matteo De
Angelis, Prof. Rumen Pozharliev

A Good Day for You, but a Bad Day for Promotion? The
Unexpected Effects of Promoting after Posting on High
Significance Life Events

» Ms. Xueqi Bao, Prof. Stephanie C. Lin, Prof. Amitava Chattopadhyay

Powered by Ex Ordo, everything you need to run a research conference.

5:15pm

5:15pm

How Social Media Influencers Increase Sales: The Roles of
Influencer Type, Brand Popularity, and Need for Uniqueness via
Influencer-Brand Congruence

» Prof. Melis Ceylan, Prof. Ceren Hayran

Generating Direct Sales in Influencer Marketing: Evidence from
Secondary Data and Three Field Studies

» Mr. Maximilian Beichert, Dr. Andreas Bayerl, Prof. Jacob Goldenberg,
Prof. Andreas Lanz

11.03 Special Session - Overcoming Judgment Biases for Better
Decisions

Jefferson
Chaired by: Prof. Joachim Vosgerau

A Framing Effect in The Judgment of Discrimination
» Dr. Xilin Li, Prof. Christopher Hsee

When Do People Underappreciate and Overappreciate Low-
Emission Products?

» Ms. Yvonne Huang, Prof. Yang Yang, Dr. Felipe M. Affonso

The Visual Decoupling Effect: Visually Decoupling the Behavior-
Bonus Link Encourages Decisions Based on Intrinsic Preferences

» Mr. Yue Zhang, Prof. Yanping Tu

11.04 Special Session - Causal Attributions in Consumer Behavior
Willow A
Chaired by: Dr. Giulia Maimone

Causal Discounting as a Framework for Charitable Credit
» Dr. Stephanie Chen

America’s Got Sob Story or Talent? The Influence of Hardship in
Merit-based Decisions

» Ms. Ziwei Wei, Dr. Evan Weingarten, Dr. Adriana Samper
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lliness Severity and Consumers’ Expectations of Side Effects
» Ms. Ozlem Tetik, Dr. David Faro, Dr. Simona Botti, Dr. Monika Heller

Not All Attributions Are Self-Serving: A Preference for Agency over
Negative Outcomes

» Dr. Giulia Maimone, Prof. Joachim Vosgerau, Dr. Ayelet Gneezy

11.05 Special Session - Numeric Judgments and Decisions
Willow B
Chaired by: Ms. Amanda Geiser

When do people predict a trend will progress vs. regress?
» Prof. Joowon Klusowski

Consumers Overlook the Value of Systematic Error and
Disagreement

» Mr. lay Naborn, Dr. Quentin Andre, Dr. Hannah Perfecto, Dr. Samuel
Hirshman, Dr. Nicholas Reinholtz

Smaller is Likelier: How Number Size Influences Risk Perception
» Ms. Amanda Geiser, Dr. Leif nelson

Framing the prices of upgrades in terms of their add-on prices
skews preferences

» Mr. William Ryan, Ms. Kristine Cho, Dr. Ellen Evers

11.07 Unconventional Paths to Purchase: Exploring Decision Biases
in Consumer Purchases

Aspen
Chaired by: Dr. Rafael Demczuk

Compliance technique and its effect on purchases applied to
retail strategies.

» Dr. Rafael Demczuk, Dr. Daniel Fernandes, Dr. Danielle Mantovani

Powered by Ex Ordo, everything you need to run a research conference.

5:15pm

5:15pm

Inaction neglect
» Ms. Michelle Kim, Prof. On Amir

Variety-Seeking in Joint Decisions

» Mr. Nuno Jose Lopes, Mr. Ignacio Rodriguez-Carrefio, Mrs. Cristina
Etayo, Mrs. Elena Reutskaja

Decisions with Many effects: Radical Uncertainty When Certainty
is Salient

» Prof. Joshua Lewis, Ms. Erin Morrissey, Dr. Lucius Caviola

ACR 2024 Meeting (Invite Only)
Columbia

11.09 The Power of Numbers: Price Ignorance, Sampling Enjoyment,
and Diffusion of Consequence

Seneca
Chaired by: Dr. Han Gong

Precision Makes Tightness Better: The Interactive Effect of
Interstitial Space and Number Precision on Purchase Intention

» Dr. Han Gong, Ms. Na Hou

Consumer Trust and Product Choice in Online Marketplace: A
Motivated Belief Perspective

» Ms. Yu (Anna) Lin, Prof. Xianchi Dai, Prof. Wenjie Tang

Is (Price) Ignorance Bliss? Consumer Misprediction of Sampling
Enjoyment
» Dr. Siyuan Yin, Dr. Cait Lamberton

Diffusion of Consequence: Consumers Are Less Upset When
Consequences Are Shared by a Large Number of Victims

» Dr. Tianyi Li, Dr. David Gal
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11.10 The Paradox of Ownership: Insights into Consumer Sub-Goals,

Upgraded Choices, and Fickleness
Boren
Chaired by: Dr. Nirajana Mishra

Psychological Ownership and Territorial Behaviors in Rental
Transactions: Why “Who"” You Rent from Matters

» Dr. Nirajana Mishra, Dr. Sarah Whitley

Equal steps to reach the goal: The preference for equal-sized sub-
goals

» Ms. Alisha Dhal, Prof. Sanjeev Tripathi, Prof. Sudipta Mandal

From Possession to Preference: Examining the Role of
Psychological Ownership in Upgraded Choice Decisions

» Ms. Xuan zhang, Prof. LiLi Wang, Prof. Ata Jami

Satisfied yet Disloyal: A Portrait of Fickle Consumers
» Dr. Ekin Ok, Prof. Dale Griffin, Prof. Darren Dahl

11.11 Retail Revolution: Navigating Consumer Compliance,
Subscription Boxes, and Virtual Consumption

Greenwood
Chaired by: Dr. Stephanie Dellande

Flipping Consumer Compliance on Its Head
» Mr. Jared Wong, Dr. Stephanie Dellande

Should | Take A Dip? A Trifocal Conceptualization of the
Subscription Box Customer Journey

» Dr. Ishani Banerji, Dr. Aditya Gupta, Dr. Seth Ketron

Just a Matter of Taste: How Virtual Consumption Affects
Uniqueness-Seeking Tendency

» Dr. Qing Tang, Prof. Xun (Irene) Huang, Prof. Kuangjie Zhang

Powered by Ex Ordo, everything you need to run a research conference.

5:15pm

5:15pm

7pm

“Free Trial” or “Free Gift”: Access (vs. Ownership) Offering
Prolongs Happiness

» Dr. Yuechen Wu, Dr. Bowen Ruan, Dr. Xing-Yu (Marcos) Chu

11.12 Consumer Values: Unraveling Individual Differences
Redwood A&B
Chaired by: Dr. Charlene Chu

Experiential Values: Scale Development and Validation
» Dr. Charlene Chu

Consumer Self-Development: A New Dimension of Well-Being

» Dr. Justin McManus, Dr. Sergio Carvalho, Dr. Valerie Trifts, Dr.
Raymond Mar

The Knowledgeable Maximizer Effect
» Prof. Jingjing Ma, Prof. Zichuan Mo, Prof. Haiyang Yang

From Perceived Control to Simplicity: The Need for Simplicity as a
Compensatory Mechanism

» Mr. Weilun Yuen, Dr. Leonard Lee

JCP AE Meeting (Invite Only)
Capitol Hill

Closing Gala: "Rock for Good" at Seattle MoPOP! (Sponsored by
Northwestern University, Medill School of Journalism, Media,
Integrated Marketing Communications))

Seattle MoPOP
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